
'About Turnpike' display

This display gives brief details about the version of the Turnpike program you are using - in particular, the 
version number, the date of issue and whether your copy has been registered.

It is called up by taking the About Turnpike option from the Help menu.



'Access Provider' dialog

The Access Provider dialog records which Access provider you are currently using and the details of your 
access to the Internet using that Access provider, for example:

* a login/host name (or similar)
* the password used when contacting your Access provider
* the Domain Name Servers (DNS) you will be using

You can call it up by taking the Service Access option from the Configure menu (assuming you have 
Connect Admin permission).

The number and meaning of the entries in this dialog depend entirely on your Access provider. The 
current information will have been filled in either from the standard script for your Access provider or from 
the additional information that's been given about your contact with this Access provider.

The Alter button calls up a dialog through which you can switch to an alternative Access provider you 
have installed on your disk. (Just pick the Access provider you want to switch to from the drop-down list 
associated with the Access provider slot in this second dialog.)

The New button calls up a further dialog through which you can either install a new Access provider or re-
install your existing Access provider eg. because the details of your account with this Access provider 
have changed.

To install a new Access provider, click the More button, select your new Access provider from the list 
shown, click Continue, then click OK - and work through the sequence of questions about your account.

To re-install your existing Access provider, check that this provider is selected in the Select access 
provider slot, click OK - and work through the sequence of questions about your account in order to 
record the new information (though do read the section on Updating Access provider information first in 
case there are other steps you need to take).



'Configure Email' dialog

This dialog records whether you want your mail to be sent directly or via your Access provider's mail 
gateway, the places mail for you needs to be picked up from and whether mail should be sent and/or 
received automatically or just when you prompt for this to happen.

You can call it up by taking the Email transfer option from the Configure menu (assuming you have 
Connect Admin permission).

The information shown is mainly set from the 'script' installed for your Access provider and from the 
answers you gave when your Access provider was first recorded. You just need to check the information 
shown and perhaps switch some of the selections, if you so require. If you are in any doubt about any of 
these items, you should contact your Access provider.

Upper part of the dialog: Covers the sending of email.

Mail gateway: Your current Access provider's Mail gateway - ie. the domain name used for sending mail 
(changes automatically when you select a different Access provider).

Only use this gateway: (Disabled in the current version) When this check box is selected (checked), 
your messages will be sent first to your Access provider's mail gateway, then on from there. When it isn't 
selected, Turnpike will send your messages direct. Sending mail via your Access provider's gateway is 
normally more efficient, so we recommend keeping this box checked.

Send automatically: When this check box is selected, any mail that is waiting in an out tray will be 
automatically sent whenever you go on-line. (Clear this box if you want mail to be sent only when you 
prompt for this.)

Lower part of the dialog: Covers the receipt of email messages.

Depending on the Access provider you use, you may receive all your mail by SMTP or you may have one 
or more 'POP' mailboxes from which you want mail to be collected. Your Access provider will be able to 
advise you on whether to receive mail by SMTP or to use POP mailboxes.

Next, Prev, Add, Remove: Allow you to see, add and remove the details of any additional POP 
mailboxes you may have. (Note: Collection of mail from more than one mail service not available in this 
version.)

SMTP, POP3, POP2: Select the type of mail service. Note: The selection made here radically affects the 
range of information shown.

Server name, Username etc (POP mailboxes only): Record the details of your mailbox. This 
information will be advised by your Access provider.

Use 'APOP' authentication (POP3 only): This box should be checked if your Access provider offers 
APOP authentication - avoids broadcasting your password. If you are unsure, consult your Access 
provider.

Fetch all, Mirror (POP only): Let you choose between having the mail downloaded to your machine (ie. 
fetched) or left in your POP mailbox so that it can be seen from another site (eg. home as well as work). If
you choose Fetch all then when mail is received by your machine it is deleted from your POP mailbox. If 
you choose Mirror then mail is only deleted from your POP mailbox when you delete or file your local 
copy.



Retry every (POP) only: Sets how often Turnpike looks to see if new mail has arrived while you are on-
line. The default of 5 minutes represents a reasonable compromise between spending a lot of time 
looking and not missing messages that arrive while you are on-line.

Receive automatically: When this box is checked, any mail that is waiting for you will be automatically 
sent whenever you go on-line. (Clear this box if you want mail to be collected only when you prompt for 
this.)

Enable POP3 server: Check this box to have the facility whereby users of your system can access their 
mailboxes from outside Turnpike automatically selected. Note: This option should not be selected lightly 
as it opens a route whereby people from outside could access your users' mail. (For further information, 
see POP3 Server option.)

Produce debug information: Check this box if prompted to do so by your Access provider's technical 
support department.



'Configure Usenet News' dialog

This dialog records where you will get Usenet news articles from, and other such details about how news 
will be handled.

You can call it up by taking the News collection option from the Configure menu (assuming you have 
Connect Admin permission).

The information shown is mainly set from the 'script' installed for your Access provider and from the 
answers you gave when your Access provider was first recorded. You just need to check the information 
shown and perhaps switch some of the selections, if you so require.

News collection section:

Server name: The address of the News Server from which you will be taking your news feed. (Note: Will 
change automatically when you select a different Access provider.)

Mail moderators @: The address to which contributions to moderated newsgroups will be sent.

Automatic collection: Check this box if you want any new articles to be automatically copied to your disk
whenever you go on-line.

Automatic expiry: Check this box if you want Turnpike to automatically expire any old news articles 
whenever you run Turnpike Connect.

Lower section:

Update newsgroup list at next connection: Select this check box if you want Turnpike to collect a fresh 
list of available newsgroups the next time you connect to your Access provider. If the box is left 
unchecked, Turnpike will simply amend your current list to add any new newsgroups.

Note: The option will be automatically cleared after the new list has been successfully collected. You don't
need to remember to clear it again yourself.

Produce debug information: Check this box if prompted to do so by your Access provider's technical 
support department.



'Errors'

If you use the Winsock supplied with Turnpike, then one of the status lines shown at the bottom of the 
screen when you are connected to your Access provider is used to show the speed at which information 
is being collected (in characters per second) and whether any 'errors' are occurring in this data 
transmission.

Each error represents a character lost through your PC not being able to transfer it to memory before the 
next character turns up. Such errors are known as 'overruns' and they have a bad effect on the speed at 
which you collect data because whenever an error occurs, not just the character that was lost has to be 
re-sent but the whole of the packet in which it appears (some 500 characters). Moreover, the packet can't 
necessarily be re-sent immediately, with the result that a single lost character can cause a great deal of 
delay.

There are three basic ways of getting rid of overruns. You can give your PC longer to react by reducing 
the serial link speed; you can arrange that your PC reacts faster; or you can fit a serial chip with more 
buffering than a humble 8250.

The serial link speed can be changed through the Speed section of the Dial Settings dialog. If your PC 
(and your Access provider) can cope, this speed should be set to four times the modem speed. If not, 
then setting a lower speed will make the characters turn up at longer intervals: for example, changing 
from 115200 to 38400 would give your PC three times as long to deal with arriving characters. Indeed, 
there is only a marginal advantage in running 14400 modems above 38400 or 28800 modems above 
57600, so it is worth trying these speeds.

However, running at less than twice the modem speed is not an ideal solution because this takes it below 
the rate at which the modem is trying to transfer data. Because modems compress the data stream 
across the phone lines, even a 14400 modem will regularly give you 3000cps or more for text transfers, 
while running at 19200 will restrict performance to a mere 1920cps and create an unwanted bottleneck. 
So even if you find that dropping the serial link speed below twice the modem speed improves 
performance by getting rid of overruns, you need a longer term solution.

To improve the responsiveness of your PC you need to identify the piece of software that is stopping it 
responding to interrupts as fast as it should. The usual suspects are the disk driver, the video driver 
(especially old S3 drivers) and software that is specially designed to improve disk performance (because 
some of this improvement may come at the expense of the performance of the rest of the system).

The first thing to do is to get the latest drivers for your hardware as the ability to work alongside high 
speed comms has only become a requirement relatively recently.

Other things which have been reported as improving the response include turning on 32bit disk access 
(and 32bit file access in WfWG), using SMARTDRV caching, turning off the IDE Block Mode Transfer 
option in the BIOS and removing special disk controller cards - though for some people such actions 
make things worse.

But if your PC uses an 8250 serial chip, the best and simplest advice is to replace this by a 16550A or 
equivalent "high-speed" serial chip. The 16550A contains a 16 byte buffer, so your PC has many times 
longer to respond to incoming characters. If you still get overruns after upgrading this chip, you need to 
turn your attention to your disk and your video driver as described above.



The Newsgroup Subscriptions dialog is the dialog that allows you to set such information as:

* How long the articles should remain on your disk (ie. their Expiry time)
* Whether the articles should be copied to your disk in full or, for example, just 'browsed' (assuming you 
have permission to do this).

It is called up from the main Turnpike program by calling up the File menu, taking the Configure option 
and selecting Newsgroups from the sub-menu that appears.

For detailed information about the dialog, press F1 to call up Help from within this dialog.



'Please type Site ID' dialog

This dialog may appear when you first run the Connect program - for you to record the Site ID of the copy 
of Turnpike you are using (as proof that you have a legal copy of the program) and a 'Site Secret' with 
which to encrypt your mail messages so that these can't be read simply by opening the mail files.

The Site ID is to be found on the Registration Card.

The Site Secret you give is up to you. Any word or phrase will do. But keep a record of it in case you ever
have to re-install your Turnpike system from scratch. If you don't use the same Site Secret again, you 
won't be able to read any of the mail messages that were received using the previous installation (though 
it is possible for someone with administrator permission to set a new Site Secret).

Note: The Site ID is given in upper case but you don't have to type it in upper case as any lower case 
characters will be automatically switched to upper case for you. You also don't need to worry whether 0 is 
a zero or the letter O, or 1 is the number one, a little l or a capital I: they're actually numbers but the 
letters will also be accepted.



Abandoning Telnet output

If you want to stop any further output being sent to your machine, try pressing F4.

This sends the Telnet 'Abort output' command to the remote computer, which should have the desired 
effect - though some systems ignore this command.

See also: Telnet's keyboard layout.



Abandoning a Telnet command

If you've started an action at the remote computer by mistake and you don't know how to stop it, try 
pressing F3.

This sends the Telnet 'Interrupt Process' command to the remote computer, which should have the 
desired effect - though some systems ignore this command.

See also: Telnet's keyboard layout.



Adding new users

Before someone can sign on and use Turnpike, they first need to be allocated their own 'seat' on the 
system (principally so that their mail is correctly delivered to them).

The person who installs Turnpike is automatically allocated seat number 001 and given the administrative 
power to allocate the other seats that are available on the system.

New users are allocated to seats from the main Turnpike program. Assuming you have suitable 
permission, call up the File menu in that program, select Configure, then pick Users from the submenu 
that appears. The details of the new users need to be recorded in the 'Configure Users' dialog that then 
appears.

For further information, either press F1 to call up Help from the Configure Users dialog or turn to the 
section on 'Allocating users to seats' in the 'Set-Up' book.



Address
The multipart name (such as turnpike.com or demon.co.uk) that gives the address of a computer on the
Internet by identifying its position within the Internet's Domain structure.



If the carrier you use for your calls requires you to enter a selection code and a PIN, enter these in the 
Carrier section of the Dial Settings dialog by clicking the New button then filling in both a name for this 
service and additional numbers that need to be dialled in the Carrier Access Numbers dialog that 
appears.

Note: If you stop using this carrier, either select the (no special codes needed) option from the drop-
down Carrier list or add New details as required. The old details can be removed by editing this entry then
clicking the Remove button



Anonymous FTP
This is a system whereby you can copy files from the public areas of certain computers' disks.

To access a computer's public area, you need to FTP to that computer, log-in as 'Anonymous' and give 
your email address as the password. 



Archie

Archie is a system that allows you to search through indexes of the files available through Anonymous 
FTP. (These indexes are amended month by month - sometimes more frequently than that - to keep them
reasonably up to date.)

The basic principle is that you give Archie either the main name of the item you are searching for or a 
word that's likely to be in the file's description. Archie then responds with a list of entries containing this 
main name, from which you then note the details for the file you want.

The main way to access Archie from Turnpike is to:
* Telnet to a suitable (public) Archie client and log in as 'archie'.

The commands to give to find the information you want then depend on the Archie client you've selected. 
The initial 'Welcome' screen may contain instructions. If not, you may be able to see a list of the 
commands supported by this Archie client by typing help [Return].

Note: If you have WS_Archie v0.5 (the version supplied with DISWIN), you will need to upgrade this to 
the latest version in order to run it alongside Turnpike. You can download the new version by FTP from:
ftp://ftp.demon.co.uk/pub/mirrors/simtel/win3/winsock/wsarchxx.zip



Arranging for receipt and delivery of mail

Before email can be received or delivered, information such as where your email messages will arrive 
from needs to be recorded - eg. the details of your POP mailbox(es) if you have any of these.

In general, all the information that's needed will either be available to Turnpike from the standard script for
your Access provider or from answers given when this Access provider was first selected. Turnpike will 
also have arranged that mail will automatically be sent and received whenever you go on-line.

If you want to check any of the details that have been set, or you want mail to be sent or collected only 
when you prompt this to happen (and you have suitable administrative powers), take the Email transfer 
option from the Configure menu on the main Turnpike Connect screen.

You can then set the required information about how mail will be sent in the upper part of the dialog that is
displayed - and about where mail is to be collected from in the lower part of this dialog.

Click here to see more about the dialog in which this information is set
or press F1 to call up this Help file when this dialog is on your screen.



Asking 'Are you there?' (in Telnet)

To check that the remote computer you've logged into is responding, you can ask it the question 'Are you 
there?' by pressing your F2 key. However, the lack of a reply doesn't necessarily mean that the computer 
has 'died' as not all computers answer this question.



Backing up your Turnpike files
As in any program, it is a good idea for the person who has the role of system administrator to keep back-
up copies of important files.

In Turnpike, the files to back up are:
From the Turnpike directory: TURNPIKE.USR

The .INI files
Any .ACC file that has been modified
Any MDM file that has been modified

From the Mail directory: MSPOOL
MAILBASE
ADDRBOOK

From the News directory: NSPOOL
NEWSBASE

plus the whole of each user's directory (which have names of the form USERxxx).

Other files don't need to be backed-up because they can, if necessary, be recovered either by re-installing
Turnpike or, in the case of the additional files in the News directory, by re-building the Newsbase (from the
main Turnpike program).



Browsing
To browse a newsgroup is to download just the header of each article. This saves a considerable amount 
of disk space while still allowing you to see whether there is anything of interest to you.

If you want to browse a particular newsgroup, you need set the Type of this newsgroup to Browse in the 
Newsgroup Subscriptions dialog .



COM ports
Most PCs are supplied with two 'COM' or 'Serial' ports, though you may have more if you've added any 
plug-in cards to your PC. Typically one of of these ports will have your mouse attached to it, assuming 
you use a 'serial' mouse.

These ports are referred to internally as 'Com1', 'Com2' etc. and each is associated with an 'IRQ' and an 
I/O Address. If you are running Turnpike under Windows 3.x, you can find out which COM ports you have 
and what their IRQs and Addresses are from an MSD report. If you are running Turnpike under Windows 
95, you can get this information either from an MSD report or by calling up the Control Panel, double-
clicking on System, selecting the Device Manager and then examining the properties of the COM ports 
that are listed. (Or you can try seeing whether this information is given in the books supplied with your PC
and any plug-in cards you've added.)

In simple terms, you can plug your modem into any free serial port.

If you just have the standard two ports with your mouse fitted into one of them, simply plug your modem 
into the other port. You then just need to identify which port is 'Com1' and which is 'Com2'. If you are 
lucky, the connectors on your PC may be marked 'Com1' and 'Com2': if not, it's a matter of seeing 
whether you can access your modem or not!

If you have fitted a 16550 (or similar) serial card, you should plug your modem into the serial port supplied
on that card. This port will typically have been configured as 'Com3'. However, you then need to ensure 
that your mouse is attached to 'Com2' rather than 'Com1' because 'Com1' and 'Com3' are both set by 
default to use IRQ 4. One way of avoiding the resulting conflict would be to change the IRQ associated 
with 'Com3' but in practice it's very much easier to move the mouse to 'Com2' which (along with 'Com4') is
set by default to use IRQ 3.

Note: (i) If your PC has an internal modem, you probably already know which COM port this is associated
with. Again, you need to ensure that there is no IRQ conflict with the mouse but this will probably have 
already been sorted out for you.

(ii) If your machine has a 'Com4', don't attach your modem to this unless you absolutely have to because 
you may then have problems as a result of the modem interfering with your video card.

If you are still in doubt, consult your hardware supplier.



Calling up information by Telnet

If an information resource you want to use is accessed by Telnet, then:

Having first connected to your Access provider:
* Click the Telnet button.
* Enter the address for the computer / service you want in the 'Telnet to' slot of the dialog that's displayed.
* Set any special port that's required in the Port box of this dialog - or, if no port is specified, leave this set 
to 'Telnet'
* Then click the Connect button.

Turnpike then contacts the computer / service you have selected, and negotiates which terminal 
emulation needs to be used. (Note: If one of the DEC emulations is selected (VT52, VT100 etc.), Turnpike
will also set the numeric keypad area of your keyboard to mimic the keypad on a DEC keyboard: see 
DEC / PC layouts.)

The remote computer / service will then ask for a login name and, if appropriate, a password. (The details 
to give here should be clear either from the information displayed by the service itself or from the listing of
Internet services from which you found out about this service.)

You are now in the hands of the application you are running at the remote computer. Read its sign-on 
message to find out how to call up instructions on how to use the service you've logged onto. (If any of 
this information has already scrolled off the screen, press F9 to switch the screen into 'Session review' 
mode: then you can scroll back over everything that has been displayed - but note that you will need to 
press F9 again before you can continue.) If no such instructions are given, try typing ? [Return].

To finish the session, do whatever the application tells you to 'quit' the service you've called up and then 
take the Close option from the File menu.

Note: Telnetting to a site that you've accessed before is easy because Turnpike remembers previous 
addresses that you have used. When you want to telnet one of these sites again, simply pull down the list 
of addresses from the 'Telnet to' slot of the dialog and select the address you want.

See also:
    Telnet keyboard options
    Logging the Telnet session
    Taking a snapshot of the screen



Changing Access provider

If you have just taken out an account with a new Access provider:

* You first need to install the appropriate 'script' (.ACC file). for this Access provider Note: Everyone needs
to do this, regardless of whether you use Turnpike to dial up this Access provider or not.
* Then if you use Turnpike to dial, you need to record the set of Dial Settings needed to dial up this 
Access provider at the PoP (Point of Presence) you want to use and ensure that this set of Dial Settings 
is selected when you come to dial up this Access provider. (If you use other software to dial, it is up to that
software what other steps you need to take in order to select your new Access provider.)

If you have already recorded details of this Access provider:

* You simply need to ensure that this set of Dial Settings is selected when you come to dial up this Access
provider (assuming that you are using Turnpike to dial).

For details, simply click on the appropriate heading above.



Changing PoP (Point of Presence)

The details of which PoP you use are recorded in the Dial Settings dialog, which you can call up by 
clicking the Dialling button within the main Connect dialog (assuming you have the appropriate Dialling 
Admin permission).

What you set within this dialog depends on whether you wish to change which PoP you access your 
Access provider through permanently, or simply have it as an alternative to the PoP you have been using.

Where a permanent change is required, simply select the PoP you now want to use from the drop-down 
list of Points of Presence offered within the Dial Settings dialog, then click the Save button to record this 
new setting.

Where the new PoP is to be used as an alternative to the current PoP, you need to select the new PoP as
above but before clicking the Save button, you need to set a separate 'nickname' for this service. Then 
the new PoP can be picked out under this new nickname, leaving the previous PoP to be picked out 
under the old nickname when required.

Note: If the PoP you want is new or has changed its phone number, the number you require may not be 
included in the list of Points of Presence. Ideally, you should pick up the latest SCRIPxxx.ZIP file by FTP 
(ftp: //ftp.demon.co.uk/pub/mirrors/turnpike/scripxxx.zip) and update the Access provider script you are 
using. (Unzip this file and study the Readme.txt file it contains to find out how to install a new script.) In 
the meantime, however, you can simply type the new number over the one currently shown in the Phone 
number slot - but you must then be careful not to 'touch' the Point of Presence or the number you have 
typed will be lost.



Changing subscription information

When a newsgroup is first subscribed, Turnpike is initially set to:
* Download articles from this newsgroup to your disk in full
* Expire these articles from your disk after 3 days.

Either of these details can be changed by someone with News Admin permission. In particular, you can 
opt to download just the article headers to start with. You can also opt to have the articles from the 
newsgroup automatically marked 'to be kept', so that these articles are only removed from your disk after 
you have explicitly cancelled the 'Keep' marker on the article.

These changes need to made through the 'Newsgroup Subscriptions' dialog which is called up from the 
main Turnpike program by calling up the File menu in that program, taking the Configure option then 
selecting Newsgroups from the sub-menu that appears.

For further details, either turn to the section on 'Subscription details' in the Mail&News book or call up the 
Help file when you have the Newsgroup Subscriptions dialog on the screen.



Changing your current connection

If you want to change any aspect of your connection to the Internet -

* the modem used
* the port it is attached to
* the speed at which the serial link is set to operate
* which PoP you use
* or even, which Access provider you use

you need to make these changes in the Dial Settings dialog.

The Dial Settings dialog is called up by clicking the Dialling button within the main Connection dialog ie. 
the one that is automatically displayed when you load the Connect program. (To display this Connection 
dialog, click the Connect button on the Connect program toolbar as if you were about to dial up.)

Simply work round the dialog making the adjustments you need, then click the Save button.

Notes: (i) Before you can select either a new modem or a new Access provider, you need to install the 
appropriate 'script'. See Changing your modem / Changing your Access provider.
(ii) If you want to keep the option of dialling up using the 'old' details, be sure to set a different Nickname 
at the top of the Dial Settings dialog. Then you will be able to use the different dial-up details by picking 
the appropriate nickname from the list of Connections offered in the main Connection dialog. Otherwise, 
the new details will simply replace the old ones when you click the Save button.



Changing your modem

If you change the modem that you use and you use Turnpike to dial, you need:
* First to install the appropriate 'driver script' (.MDM file) for this modem
* And then to record this modem among the Dial Settings used when you dial up your Access provider.
(What you need to do if you use some other software to dial depends on that software.)

Both of these actions are carried out from the Dial Settings dialog, which you can call up by clicking the 
Dialling button within the main Connect dialog (assuming you have the appropriate Dialling Admin 
permission).

To install the appropriate driver script, click the New button alongside the Modem slot in this dialog, select
your modem in the list that's displayed then click the Continue button to return to the Dial Settings dialog.
(Click here to find out more about the dialog that's displayed.)

When you return to the Dial Settings dialog, you will find that the new modem has been selected in the 
Modem slot.

If you are making a permanent change to this modem, simply make the appropriate Serial port and Speed
settings, then click the Save button.

If, however, you want to carry on using your old modem, you need to make the appropriate Serial port and
Speed settings as above but before clicking the Save button, you need to set a separate 'nickname' for 
this service. Then you will be able to switch between the different modems simply by selecting the 
appropriate nickname when you connect to your Access provider.

Click here for further information about the Dial Settings dialog



Collecting News

When you go on-line, you will probably want to have any new articles that have been submitted to the 
newsgroups you subscribe to copied to your system.

Assuming you have suitable administrative powers, you can arrange for this to happen automatically 
whenever you go on-line. Any articles waiting in the Out-tray will be posted at the same time.

To have new articles downloaded automatically, select News collection from the Configure menu on the
main Turnpike Connect screen and check the 'Automatic collection' box in the Configure Usenet News 
dialog that appears.

To keep this action under your control, leave the Automatic collection option clear and use the Collect 
News option in the Services menu to select this action when you need it.

While the news is being transferred, you will see messages in a status bar at the bottom of the screen 
recording how many items are expected, how many have been collected, and how many have been filed. 
This status bar is associated with a window in which you can see in detail what's being received by 
selecting the News window from the Window menu (but if you open this window, be sure to minimise it - 
not close it - because closing it will stop the download).

There will also be a status bar showing information about the rate at which data is currently being 
transferred (in cps) and reporting any 'errors' in this transmission. If you get a lot of errors, disconnect, 
read the section of this Help file on Errors, then re-connect - but only after you've set a lower speed in the 
Dial Settings dialog, because you are currently trying to pick up data faster than your PC's serial port is 
able to handle it.

You can disconnect from your Access provider when all the items have been collected (signalled by the 
message 'News collection closed - filing continues') - but don't leave Turnpike Connect until they have all 
be filed (signalled by a separate 'News completed' message).

Note: The number of articles to be downloaded won't necessarily match the number of new articles that 
appear to be read in your newsgroups. For a start, the counts in the newsgroups don't include articles in 
threads that have been marked 'Not interesting'. They also don't include articles killed by kill rules, but 
these articles are included in the count of articles downloaded because the headers have been 
downloaded and these are included the count. Moreover, the articles that pass the kill criteria are counted
twice because the headers and the bodies are downloaded separately. However, another possible reason
for having more articles downloaded than you are offered to read is that you've got rid of a newsgroup 
you require from a newsstand but not from the overall subscription list. If this could be the case, call up 
the main Turnpike program, call up the File menu, take the Configure option, select Newsgroups from 
the sub-menu that appears - and check the list of newsgroups shown in the dialog that's displayed.



Collecting the list of newsgroups

Before you can subscribe to any of the Usenet newsgroups, you need to collect a list of the newsgroups 
available from your Access provider's news server.

Turnpike is automatically set up to collect this list the first time you use Turnpike to connect to your 
Access provider. After that, any new newsgroups that become available at the news server are 
automatically added to your original list - but though the amended list will work, it is a good idea to collect 
a fresh copy of the list every so often.

You can arrange for a fresh list to be downloaded the next time you collect news by calling up the 
Configure menu, taking the News collection option and selecting (ie. 'checking') the Update 
newsgroup list at next connection option in the 'Configure News' dialog that is displayed.

The list of newsgroups is quite long as there are over 14000 newsgroups, but it should be possible to 
collect the complete list in around 5 minutes (assuming that you aren't trying to do this at a particularly 
busy time). If it takes much longer than this, you probably need to make some adjustments to the way in 
which your machine is set up - because whatever is making the collection of this list slow is likely to affect 
every transfer of information you make in the future.

The possible causes of the problem are described in the section on 'Enhancing the speed of collection', 
but for now let Turnpike finish collecting the list - because otherwise it will try pick up a full list every time it
connects to collect news until it is successful.

Note: In order for the complete list to be collected, you need to stay connected to your Access provider 
until the 'News collection closed - filing continues' message appears - after which you can disconnect 
from your Access provider (by clicking the Disconnect button on the toolbar). But you must then stay in 
the Connect program until the separate 'News completed, xxxx articles fetched and filed' message 
appears, otherwise the list won't be filed correctly and will have to be collected again the next time you 
connect to your Access provider.



Colour Selection dialog

This dialog lets you select the colour used either for text or as a background. (The type of text or 
background for which the colour is to be used is itself part of the dialog.)

It is called up by taking the Colour option from an Options menu.

The dialog offers both a 'palette' of 'Basic' colours from which to pick and, on the right, a complete colour 
spectrum from which to select a 'custom' colour if you wish. If you want, you can add the colours you pick 
out from the colour spectrum to an additional palette of 'Custom' colours.

To use a colour from a palette, you simply need to click on the colour in the palette.

To pick a custom colour from the spectrum, you click on the colour you want in the spectrum, then set its 
'luminosity' (the amount of white/black you want in the colour) by clicking on the sample bar to the right of 
the spectrum.

You can then add this custom colour to the Custom palette by clicking the Add to Custom Colors button.

(If you want the new colour to replace an existing colour in the Custom palette, select the entry in the 
Custom palette before setting up the new colour. The 'old' colour will be replaced by the new one when 
you click the Add to Custom Colors button.)

IMPORTANT: Text is only ever displayed using the 'Solid' part of the colour you select. So when setting 
the colour for text, be sure to check the 'Solid' part of the sample shown in the dialog because this is what
will be used.



Commands menu (in Telnet)

This lets you issue commands for some standard facilities. Note that some of these commands are 
actually transmitted to the remote computer and so whether any action is taken will depend on the remote
computer.

Are you there?
Interrupt Process
Abort Output
Erase Line



Commands menu: Abort Output

Sends the Telnet command for abandoning any further output from the current action. (Note: Whether 
there is any response to this command depends on the remote computer you are connected to.)

Quick keystroke: F4



Commands menu: Are you there?

Allows you to check whether the remote computer you are logged into is still responding. However, the 
lack of a reply won't necessarily mean that the computer has 'died' as not all computers answer this 
question.

Quick keystroke: F2



Commands menu: Erase Line

Deletes the current command line (where commands are being sent line-by-line).

Quick keystroke: Ctrl + ¬



Commands menu: Interrupt Process

Sends the Telnet command for halting the current action. (Note: It depends on the remote computer 
whether there is any response to this command.)

Quick keystroke: F3



Configure menu

This allows you to configure the various aspects of how Turnpike is installed on your system. The menu 
options are:

Host
Timezone
Email transfer
News collection

Service access
Winsock used
Site Key

Telnet Emulation
Telnet Keyboard

Toolbar buttons

Note: The majority of these options are only available to you if you have Connect Admin permission.



Configure menu: Email transfer

Lets you see (and if appropriate set) the details of how mail is sent and received. In particular, it also lets 
you control whether your mail is automatically sent and received whenever you go on-line or just when 
you prompt for this to happen (assuming you have Connect Admin permission).

Click here for information about the dialog that is displayed
or press F1 to call up this Help file when this dialog is on the screen



Configure menu: Host

Calls up the dialog which records:
* your local domain
* the domain name of the machine you use (your host machine)
* the domain(s) for which your machine will accept mail
(assuming you have Connect Admin permission)

Click here for further information about the dialog displayed
or press F1 to call up this Help file when the dialog is displayed on the screen.



Configure menu: News collection

Lets you set where you obtain Usenet news from, and lets you opt for new news articles to be 
automatically copied to your disk whenever you go on-line (assuming you have Connect Admin 
permission).

Click here for information about the dialog that is displayed
or press F1 to call up this Help file when this dialog is on the screen



Configure menu: Service Access

Calls up a dialog which records such information as your Login name , your IP address and the Domain 
Name server(s) you use (assuming you have Connect Admin permission).

This dialog can also be used to install a new Access provider or to record fresh details about your account
with your existing Access provider.

Click here for further information about this dialog
or Here for information about changing your Access provider.



Configure menu: Site Key

Lets you inspect, and if necessary change, the basic registration information about your system - Site ID, 
Site Key etc.

For information about the dialog that is displayed, either click here or press F1 to call up this Help file 
when you have this dialog on your screen.



Configure menu: Timezone

Lets you record the timezone in which you are working - ie. the number of hours ahead or behind GMT 
you are (assuming you have Connect Admin permission).

For further information, either click here or press F1 to call up this Help file when the dialog in which you 
set the timezone is displayed on your screen.



Configure menu: Toolbar buttons

Lets you add, remove or re-assign the buttons on the toolbar (assuming you have Connect Admin 
permission).

For further information, see User-definable buttons.



Configure menu: Winsock used

Lets you select which Winsock you wish to use out of the ones available on your system (assuming you 
have Connect Admin permission).

For information about the dialog that is displayed, either click here or press F1 to call up this Help file 
when you have this dialog on your screen.



Configuring Turnpike

There are several areas of Turnpike which you can configure to suit your needs.

Some of these are set from the main Turnpike program; others from this Connect program. Some are 
principally for use on systems with several users such as you might find in a company, but often they can 
also be valuable on a 'home' system - particularly where you have different members of the same family 
all using the same system.

The aspects that are set from the main Turnpike program are:
* The range of people who can log-on and use the system, and the passwords they use
* The grouping of users into workgroups
* The range of email names recognised by your system
* How these can be used to set up Group Mail
* And where mail messages that use these names are routed

The aspects that can be set from the Turnpike Connect program are:
* The details of the actual connection itself - such as which access provider you use, which number you 
use to dial them up, the type of modem you have etc. etc.
* Where you obtain your news from
* Where you get your mail from
* Where the news and mail files are stored

Note: On a shared system, you won't necessarily be allowed to set all these different options yourself. 
What each user can and can't set is a matter of what permissions that user has been given by whoever 
has the job of system administrator.



Configuring your system

Introduction

Configuring for Dial-up:

How to:
Change any aspect of your current connection
Set / Change Access provider details
Configure the system for a different modem
Record the Timezone in which you work

Configuring Mail/News handling:

How to:
Set the details for receipt and delivery of mail
Record which news server you use
Select the range of newsgroups subscribed to
Change subscription information (eg. full/browsed; expiry time)
Subscribe to a mailing list
Set where the mail and news files are stored

Configuring for users:

How to:
Add new users to a shared system
Set up (or change) passwords
Set up workgroups
Set permissions
Record additional Email names

Configuring the toolbar



Connecting to your Access provider

Note: The following describes the process of connecting to your Access provider where Turnpike is used 
to dial. The procedure where you use other software to dial depends on that software.

Normally all you need to do to connect to your Access provider is load the Connect program, check that 
the correct Access provider is selected in the 'Connection' slot of the Connect to Internet dialog that is 
automatically displayed, check that a suitable Idle Timeout has been set and then click the Connect 
button in this dialog. (If the Connect program is already loaded, click the Connect button on the toolbar to
call up the Connect to Internet dialog.)

Turnpike then proceeds first to initialise your modem, then assuming that's successful, it tries to dial up 
your Access provider. The progress of the attempt to connect is shown through a sequence of messages 
in the main window of the Connect dialog, such as:

Phoning <your Access provider>
Ready to dial...
Tone...

(If the modem reports 'No dial tone', or that the number is 'Busy' (ie. engaged) or it fails to pick up a 
carrier from your Access provider's modem ('No carrier'), Turnpike will try dialling again up to the number 
of Redials shown in the dialog. If the 'No dial tone' or 'No carrier' messages persist, see 'If you have 
difficulty connecting'. If the number remains engaged, either try again (by clicking the Redial now button) 
or leave dialling up to a time when the number is less busy.)

When contact has been established with your Access provider, you will probably see some messages 
from your Access provider (possibly including a message of the day concerning their service) then the 
Connect to Internet dialog will disappear, leaving the main Connect screen. From this select the actions 
your require, either by clicking on the buttons on the Toolbar or selecting the action from the Services 
menu.

If mail and news are transferred or old news expired, status bars at the bottom of the display will show 
how many items are expected, how many have been collected and how many have been filed. There will 
also be a status bar showing information about the rate at which data is currently being transferred (in 
cps) and reporting errors (overruns) in this transmission. If you get a lot of errors, disconnect then re-
connect but only after you've set a lower speed in the Dial Settings dialog. You are currently trying to pick 
up data faster than your PC's serial port is able to handle it.

When all the mail and news has been collected and you have finished everything that you need to be on-
line to your Access provider for, click on the Disconnect button. Note: There's no need to wait for all the 
news to be filed before you disconnect, but DON'T leave Turnpike Connect before this part of the 
operation has been completed.



Turnpike Connect Help covers:

Introduction to Turnpike Connect
Using Turnpike Help
Signing on
Menus and Buttons
Configuring your system
Going on-line
Sending and Receiving Email
Collecting News articles
Expiring News
Leaving Turnpike
Troubleshooting

and using the different on-line services the Internet offers:
WWW
Telnet
FTP
Finger
Ping
Traceroute
Other Information services that the Internet provides

Simply click on the area you want further information on.

Note: If you simply want to find out which version of Turnpike you are using, take the 'About Turnpike' 
option from the Help menu. You will then see a dialog giving brief details about the version of the software
you are using.



DEC/PC layouts (in Telnet)

If your PC is set to emulate a DEC terminal when you telnet to a remote computer, its keyboard is 
automatically set up to mimic the keyboard used on a DEC terminal.

The important difference between the keyboard used on a PC and that used on a DEC terminal is in the 
numeric keypad, which on a DEC keyboard is like this:

      

The effect of setting the PC keyboard to mimic the DEC keyboard is that:

* The four keys at the top of the PC keypad (Num Lock, /, * and -) act as the DEC PF1 - PF4 keys.
(Note: the Num Lock key continues to switch the Num Lock light but it doesn't have any effect on the 
keypad keys.)
* The 'number' keys of the keypad either generate the numbers shown or the appropriate escape 
sequences, depending on the mode selected by the remote computer.
* The grey '+' key on its own acts as the DEC '-' key, or with Ctrl, as the DEC ',' key.

If you prefer, you can set the keyboard to have its usual PC layout by taking the Keyboard option from 
the Options menu and selecting PC layout in the VT100 keyboard layout area of the dialog that is 
displayed. The effect of this is as follows:

If the PC layout is selected and Num Lock is set:

* The 'number' keys and the grey '/', '*' and '-' keys either generate ascii characters or the appropriate 
escape sequences.
* The grey '+' key acts as the DEC ',' key.
* Function keys F5 - F8 act as the DEC PF1 - PF4 keys.
(Note these keys only work as PF1 - PF4 when Num Lock is set.)

If the PC layout is selected and Num Lock is not set:

* The grey '/', '*', '+' and '-' keys generate ascii characters
* The Up, Down, Left and Right keys act as alternative cursor keys
* Home, End, PgUp, PgDn, Ins and Del don't have any effect.



Defining function keys (in Telnet)

You can, if you wish, set up the function keys on your PC to issue commands that you find that you often 
give when telnetting to some of the sites you use.

Some of the function keys are pre-set to issue some of the more common commands you require. To set 
up other function keys to give standard commands for you, take the Keyboard option from the Options 
menu and then type the command strings you wish these keys to give in the boxes in this dialog.

Note: The function keys give different commands in combination with the shift keys Shift, Ctrl and Alt. Use
the options to the right of the list of funtion key meanings to select the shift state (Normal, Shift, Ctrl and 
Alt) in which you are setting this meaning.

Click here for more information about the Telnet Keyboard dialog.



Dial Settings dialog

This dialog is automatically displayed while Turnpike is being installed, and by clicking the Dialling button 
within the main Connect dialog (assuming you have Dialling Admin permission).

Its job is to record the details of how the connection to your Access provider is to be made. When all the 
details have been set, click on Save.

Nickname: Slot for the name by which you will pick out this set of dial settings on the main Connection 
dialog - set by default to the name of the Access provider that you use. (Settable because you can have 
several sets of dial settings, saved under different nicknames.)

Access Provider: The Access provider you will be using. To switch to a different Access provider, either 
pick from the drop-down list of installed Access providers or click the New button alongside to install (or 
re-install) a different Access provider: see Changing Access provider.

Modem: The modem you will be using. To switch to a different modem, either pick from the drop-down list
of installed modems or click the New button alongside to install a different modem: see Changing your 
modem.

Dialling: Details of the phone link used.
Select Tone or Pulse according to which form of dialling your phone uses. (Note: Most modern 
phones use tone dialling.)
Specify any special PABX line access codes.
Specify any alternative carrier details.

Point of Presence: The Point of Presence (PoP) is where you dial to connect to your Access provider. 
Some Access providers have just one, others have many. Select by name from the list installed when you 
installed your Access provider - the phone number will be filled in automatically. To see the list, click on 
the arrow at the right of the slot. See also Changing PoP.

Serial port: In most cases, you simply need to select the COM port to which the modem is connected - 
though you should check that this will not interfere with any other equipment you are using, such as a 
serial mouse. (If you are not sure, consult your hardware supplier.) But if your serial port/modem is non 
standard, you will need to select other and fill in the Address and the IRQ (Interrupt request) number it 
uses - these details should be in your hardware manual or available from your hardware supplier.

The additional Use comm.drv option selects your COMM.DRV in place of the VxD drivers of the supplied
stack. You may need this option if your modem doesn't include a serial chip (or equivalent) or if software 
error correction / data compression is used (WINRPI).

Speed: The baud rate at which the serial link is to transfer information to your Access provider. This is not
simply the quoted speed of the modem as data compression is used which increases the effective 
transmission speed. For example a 14.4K modem can probably transfer at 38400 and a V34 28.8K 
modem at 115200 (though not all Access providers support speeds that fast). But if you find 'errors' are 
reported when you connect to your Access provider, you should study the section on Errors, then reduce 
this speed step by step until these errors go away.

Note: Don't worry if you're not sure what you need to set for any aspect of the connection. If you get 
something wrong, you can readily come back to this dialog and make the necessary changes - simply by 
taking the Dialling option included in the main Connect dialog.



Disabling the Sign-on dialog

If you don't need password protection against someone else reading your mail messages, you might like 
to make running Turnpike really simple for you by disabling the Sign-on dialog.

You are not, however, recommended to disable this dialog if other people use your machine to call up 
Turnpike because, if you think about it, everyone who loads the program after you, will be signed on as 
you, see your files etc. etc. until such time as the sign-on dialog is re-enabled.

To disable the sign-on dialog, you need to call up the 'Edit sign-on details' dialog from within the main 
Turnpike program - by taking the Configure option from the File menu in that program, then taking the 
Users option from the sub-menu that appears. (The dialog you require either appears automatically or 
after selecting your entry from a list of users and taking the Edit option.)

Simply select the option to 'Disable the sign on dialog'. Any password that has been set will be 
automatically cleared.

Note: If you later decide to set a password, the sign-on dialog will automatically be restored.

For further information, either press [F1] to call up Help from within the Edit sign-on details dialog or turn 
to the section on 'Giving yourself a different sign-on name or password' in the 'Set-Up' book.



Domain Name Servers (DNS)
Domain Name Servers convert the domain names used to specify where a message needs to be sent 
into the IP addresses that are actually used to direct messages etc. across the Internet. They are 
identified in the Access Provider dialog by quoting the IP addresses of the computers on which they run.



Domain name
The multipart name that gives the address of a computer on the Internet by identifying its position within 
the Internet's Domain structure.



If you are using Windows 3.1 or similar, the System ini file may be changed as follows: Note: If you 
have any problems following these instructions, call Turnpike Support on 0181-371 1010*.

1. Close this program and any other applications that you are currently running on your PC.

2. Display the Windows File Manager.

3. Double-click on C: drive, then double-click the Windows directory on this drive to open it.

4. Scroll down the contents of this folder until you find System.ini, then use the Copy command in the 
File menu to make a back-up copy of this file, called for example SYSTEM.OLD, for use in case of 
accident.

5. Double-click on the System.ini file to open it. (It will probably open automatically, but if you see a 
message telling you that no application is associated with this file, follow the instructions given to 
associate Text file (notepad.exe) with the file, then try again.)

6. When the System.ini has been opened, scroll down it until you find the section headed [386Enh] and 
look for the lines in this section that start device=c:\turnpike\v........ You should have three (and only 
three) of these lines as follows:

                device=c:\turnpike\vntstimd.exe
                device=c:\turnpike\vtcprac.386
                device=c:\turnpike\vntspsd.386

Note: These device= lines assume you installed Turnpike in the root of your C: drive. If you installed it 
somewhere else, you will need modify these lines accordingly.

7. Make whatever changes you need to give you these three lines in your [386Enh] section, then exit 
from the program that you're using to edit this file. When the message appears, accept the option to save 
the changes you've made.

8. Restart Windows, and double-click on the Connect icon in the Turnpike program group to run Turnpike 
Connect.

Assuming all is now well, you can delete the back-up copy of your old System.ini file that you made at 
Step 3.

*Calls to this number may be monitored for training purposes. This information may be used for marketing purposes.



If you are using Windows 95, the System ini file may be changed as follows: Note: If you have any 
problems following these instructions, call Turnpike Support on 0181-371 1010*.

1. Close this program and any other applications that you are currently running on your PC.

2. Call up the Windows 95 Explorer.

3. Double-click on the C: drive in the All folders list.

4. Double-click on the Windows folder within the C: drive.

5. Scroll down the contents of this folder until you find System.ini, then use the Copy and Paste 
commands in the Edit menu to make a back-up copy of this file for use in case of accident.

6. Double-click on the System.ini file to open it. (It will probably open automatically, but if you see a 
dialog asking which program to use, pick NOTEPAD.)

7. When the System.ini has been opened, scroll down it until you find the section headed [386Enh] and 
look for the lines in this section that start device=c:\turnpike\v........ You should have three (and only 
three) of these lines as follows:

                device=c:\turnpike\vntstimd.vxd
                device=c:\turnpike\vtcprac.386
                device=c:\turnpike\vntspsd.386

and definitely no device=c:\turnpike\vntstimd.exe line.

Note: These device= lines assume you installed Turnpike in the root of your C: drive. If you installed it 
somewhere else, you will need modify these lines accordingly.

8. Make whatever changes you need to give you these three lines in your [386Enh] section, then exit 
from the program that you're using to edit this file. When the message appears, accept the option to save 
the changes you've made.

9. Restart Windows, and double-click on the Connect icon in the Turnpike folder to run Turnpike Connect.

Assuming all is now well, you can delete the back-up copy of your old System.ini file that you made at 
Step 4.

*Calls to this number may be monitored for training purposes. This information may be used for marketing purposes.



Edit menu

Cut
Copy
Paste



Edit menu: Copy

Copies the currently-selected section of the record of commands and responses.

Quick keystroke: Ctrl + C

See also: Cut and Paste



Edit menu: Cut

Removes the currently-selected section from the record of commands and responses.

Quick keystroke: Ctrl + X

See also: Copy and Paste



Edit menu: Paste

Inserts a copy of a selection of commands and responses previously either cut or copied from a different 
part of the session record.

The effect will be as if you had typed this information at the keyboard.

Quick keystroke: Ctrl + V

See also: Cut and Copy



Email names

The email name (written before the @ in the email address) identifies the user to which a particular piece 
of mail is being sent. This 'name' can include digits and some punctuation marks but it can't include 
spaces or commas. It also needs to be different from the other email names used on your system.

Each user usually starts with just their sign-on name as their email name, but in practice, it is often useful 
for each user to have a range of email names. For a start, it increases the chances of someone sending a
message specifying a name that the system will recognise as meaning 'for you'.

In Turnpike, you can also use additional email names to make it easy to sort your mail into different 
categories by arranging that you use one email name when corresponding with friends, another for 
business colleagues, another for sales enquiries ... and so on. (How this is organised is explained in the 
Turnpike Mail&News book.)

On a shared system, you can also arrange that some email names are private (ie. can only be used by 
one person), while others can be used by a whole range of people - for example allowing everyone in a 
Sales department to both send out and process messages from sales@yourcompany.com. Mail based 
on email names with multiple users is known as Group Mail and is a powerful feature of Turnpike.

Email names are set up (and changed) from the main Turnpike program. Assuming you have the 
appropriate permission, you select Configure from the File menu of that program, then pick Email 
names from the submenu that appears. This calls up the 'Email names' dialog which gives a list of all the 
email names currently in use, together with a Create button through which new names can be set up and 
an Edit button to use to change any aspect of names which have already been set up. Selecting either of 
these options calls up a 'Usage of email name' dialog in which the details of the email name can be set.

For further information, turn to the section on Email names in either the Set-Up book or the Mail&News 
book.



Enhancing the speed of collection

If news seems to be taking a long time to collect, look at the status bars at the bottom of the screen.

Assuming you are using the Winsock supplied with Turnpike, one of these status bars will be showing the 
rate at which information is being collected in characters per second (cps), together with a figure for the 
number of errors.

Ideally you should be getting between 1600 and 3000cps with a 14400 modem (depending on the amount
of encoded or compressed information that's being transferred) or twice that with a 28800 modem.

If the rate of collection is lower than this, maybe even dropping to zero at times, the problem could simply 
be that you have dialled up at a very busy time. All you can do about that is pick a less busy time to dial 
up in future.

But if the figures on the status bar show that there have been errors in the transmission, news collection 
is taking a long time because your PC is failing to cope with the data that is arriving. What you do about 
this is described in the section on Errors.

Notes: (i) If you aren't using the Winsock supplied with Turnpike, you will need to look elsewhere for 
performance information. One place to look is FTP transfers, while if you are using Windows 95's Dial-Up 
Networking (DUN) software you can get performance information from its 'System Monitor'.

(ii) If what is taking the time is not so much collecting news as filing the news that has been collected, 
then it may be worth 'defragging' your hard disk and/or turning on (a recent version of) SMARTDRV or 
some other disk cache and enabling write caching. If you are using a disk compression program such as 
Stacker or DoubleSpace, this will be making filing slower too. Indeed it would be better to arrange that 
your news and mail are stored on an uncompressed section of your hard disk: then articles would be filed 
much faster at a cost of very little extra disk space as the news and mail files are already compressed. (If 
terms like 'cache' and 'defragging' don't mean a lot to you, consult a computer expert!)

If filing still seems to take a long time, remember that Turnpike isn't simply writing the information to disk: 
it is also encrypting it for privacy, compressing it and indexing it ready to give you easy access when you 
come to read the articles.



Expiring News

Before downloading new news articles, you will probably want to erase from your disk any news articles 
that have passed their Expiry date.

You can arrange for this to happen automatically whenever you run the Connect program - or you can 
arrange that news is only expired when you prompt for this to happen.

If you have Connect Admin permission, you can arrange for news to be expired automatically by selecting
News collection from the Configure menu on the main Turnpike Connect screen and checking the 
'Automatic expiry' box in the dialog that is displayed.

If you want news only to be expired when you prompt for this to happen, leave the Automatic expiry box 
clear. You can in any case use the Expire News option in the Services menu to prompt Turnpike to 
expire the news when you want this to happen.

(While the old news articles are being deleted, you will see messages at the bottom of the screen 
recording Turnpike's progress through this task.)

Note: If you want to change the length of time the articles from a particular newsgroup stay on your disk, 
set a different Expiry time for the group in the Newsgroup Subscriptions dialog. If you want to keep 
particular articles past their Expiry date, you need to select them within the appropriate newsstand in the 
main Turnpike program and use the Keep option in the Article menu to mark them to be kept. (For further 
information, see either the Turnpike Mail&News book or call up the on-screen Help from within the main 
Turnpike program.)



Expiry
News articles are only kept for a limited amount of time, after which they are erased from the newsbase. 
The date on which a news article is due to be erased is known as its Expiry Date (worked out from the 
date the article was downloaded and the Expiry time currently set for the group in the Newsgroup 
Subscriptions dialog), while the process of erasing those articles which have past their Expiry Date is 
known as Expiring the news.



FTP

FTP stands for File Transfer Protocol and it is the facility that lets you 'download' files from a remote 
computer across the Internet (and to 'upload' your files to the remote computer, if you have permission to 
do this).

The program supplied with Turnpike to let you transfer files in this way is called WS-FTP Pro.

A wide range of files are available for you to copy over the Internet -public archives, pictures, maps, 
'shareware' and 'public domain' programs, among others. Details of the files that are available may 
appear in articles in Usenet newsgroups, catalogues of Internet services or other on-line or printed 
information. There's also a system known as Archie that can be used to search for files available for free 
through a system known as Anonymous FTP.

Once you have the details of the file you want to transfer, the basic procedure is just to
* Click the WS-FTP button on the Connect program toolbar.
* Enter the computer's address, the appropriate log-in name, password, account etc. information in the 
dialog that's displayed - or pick from the drop-down list of predefined 'Session Profiles'.
* Click OK to connect to the selected computer.
* Open the directory containing the file (or files) you want to copy and the directory into which you want to 
copy them on the main FTP screen.
* Drag and drop the files you want to transfer between the directory on the Remote system and the one 
on your Local system (or use the Arrow buttons between the two lists if you prefer)

There are, however, a number of further points to consider.

For a start, working out which file to copy from the list of possibilities is not as easy as it may sound as 
there are often a number of very similar entries. The principal thing to check, particularly where you are 
looking for a copy of a program, is that the file is in a suitable format for use on your machine. A program 
that has been set up for a Macintosh is absolutely no use on a PC! You should also check that you will be 
getting the latest version and that the file is coming from a reputable source: the last thing you want is to 
copy a file that's been infected with a virus.

The other thing to check up on is whether the file is compressed. You can usually tell this from its filename
- and in particular, from its filetype. For example, a file that has been compressed using the PKZIP 
program will have the filetype .ZIP, while a file with the suffix .tar was created using a tar command and 
contains a compilation of files. (There's more information on filetypes and file suffices in the FTP section 
of the Online Turnpike book.) To make use of these files, you need the appropriate tools available on your
computer to 'decompress' and 'de-tar' the files once they have been transferred. Moreover, the program 
that did the compilation or the compression may be specific to one particular type of computer - but you 
should be able to find (by FTP!) programs for PCs that will de-compress and de-tar the files for you.

A further complication is that there are two forms of file transfer - 'ASCII' and 'Binary'. 'Binary' transfer 
gives you a simple bit-by-bit copy of the source file and is the type to use where you are copying a 
program. 'ASCII' transfer copies the file character-by-character, allowing for the difference in the codes 
used to represent different characters on the two machines. It is important to pick the correct sort of 
transfer for the type of file you are copying. If the file you want to transfer contains text), you will need to 
use 'ASCII' transfer so that the text is readable on your machine. You should also opt for ASCII transfer 
when you want to transfer a uuencoded file as this is a mixture of text and data encoded as text. But if a 
file has been compressed, you need to ensure that it is transferred as a binary file.

The final point to note about FTP is that it demands quite a lot of resources from the computer from which
the file is copied. It is therefore a basic rule of FTP 'netiquette' that you transfer files at times when the 
remote computer isn't being used for real work ie. outside working hours at the remote computer. Indeed, 
some computer systems only allow Anonymous FTP between certain times at their site. The crucial thing 



to remember is that the computer you are accessing could be in a very different time zone to you. 
California, for example, is eight hours behind the UK so while midnight may seem plenty late enough to 
be sociable in the UK, it is only 4 o'clock in the afternoon in California and so well within working hours 
there.

* For further information about using FTP, press F1 after you have called up the main FTP screen 
to call up the WS-FTP software's own Help information. This information is held separately from 
this Help file.



File Paths dialog

This dialog lists the location of:
* Your personal Turnpike files (the Server path)
* The Mail received and sent from your machine (the Email path)
* The Usenet News copied to your system (the News path)

It is displayed by clicking the Paths button within the Sign-on dialog.

To change any of these, click the adjacent Browse button, then use the File Selector that's shown to 
locate this directory.

Note: Start by selecting the Server path; the other two paths will then automatically change to match.



File Save dialogs

Several actions within Turnpike involve saving a file on disk.

Where appropriate, Turnpike offers a standard Windows File Save dialog for you to use to pick out where 
the file should be stored. This dialog will be automatically set up to show what is being saved in its title 
and, where appropriate, to set the required filetype extension.

Simply use the right-hand file selector to set the appropriate directory, then type the required filename in 
the File Name slot - in the usual way.



File Selectors

Several actions within Turnpike require you to pick out a file or a directory to work with.

In each case, Turnpike offers a standard Windows File Selector dialog for you to use to pick out the file or 
path that is required. This dialog will be automatically set up to show what is needed in its title and, where 
appropriate, to select files with the required filetype extension (though you also have the option of setting 
the list of files to All files if required).

Simply use the right-hand file selector to set the directory, then the left-hand file selector to select the 
specific file or path that's required - in the usual way.



File menu

Log...
Print...
Print Preview
Print Setup...
Print Font
Rebuild database
Exit/Close



File menu: Close

Closes the on-line function you're currently using (FTP, Telnet, Finger, Ping or Traceroute).



File menu: Exit

Exits from Turnpike Connect.



File menu: Log option

Selecting the Log option brings up a submenu from which you can opt to:

* Log the entire session
* Log from this point on
* Or stop logging

After opting to log either the whole session or from this point on, you are then asked to specify the .log file
in which the sequence of commands and responses shown on the screen are to be logged.



File menu: Print

Prints one or more copies of the current command/response sequence - using your current printer set-up.

When you take this option, a dialog appears through which you can set the number of copies and the 
range of pages to be printed. This dialog also includes a Print setup button through which you can 
change the printer and type of paper that's used - or you can set these things up in advance by taking the 
Print setup option from the File menu.

Quick keystroke: Ctrl + P

See also: Print Font,    Print Preview and Print Setup



File menu: Print Font

Calls up a dialog through which you can set the font to be used when printing.

Click here for information about the Font dialog
(or press F1 to call up this Help file when you have this dialog on the screen)



File menu: Print Preview

Shows you (as closely as possible) on the screen how the current sequence of commands and responses
would look it if you printed it on your current printer setup.

Within the Preview display you can show different pages and zoom in on parts of the display you are 
particularly interested in - in just the same way as you can zoom in mail messages or news articles that 
you preview using the main Turnpike program (see eg. the Mail&News book).

See also: Print Preview toolbar; Print and Print Setup



File menu: Print Setup

Lets you set the printer and paper used if you choose to print - or preview - the sequences of commands 
and responses you have worked through in a particular session.

When you take this option, a version of the standard Windows Print setup dialog is displayed, through 
which you can set the printer and type of paper that's to be used.



File menu: Rebuild database

Lets someone with the appropriate permission create a new version of the mailbase, newsbase or 
address book in which any wasted space is recovered. This can restore valuable disk space to you. It can
also be used to recover these databases (or at least, as much as possible of these) should they become 
corrupted.

Just select Mail or News or Address book as appropriate from the message that is displayed.

Greyed out if you don't have Rebuild Files permission.

For further information, see Rebuilding your mailbase etc.



Fingering people or computers

The Finger feature lets you check whether a particular person accesses the Internet via a given host and 
to find out their login name on that system - assuming that there's a Finger server on their host. (If there 
isn't a Finger server, you won't get any reply.)

It can also be used to find out who is currently logged on at a particular host and to examine the contents 
of a user's 'Project' and/or 'Plan' file. (These files are principally intended to be used for a summary of 
what the user is working on but they are sometimes used for such things as weather reports and football 
scores.)

To find out who is currently logged on to a particular host:
* Click on the Finger button.
* Enter the Domain name for this host in the dialog that's displayed. (Note: This domain name needs to be
given in full, even where you are fingering one of your Access provider's sites.)
* Then click the Connect button.

To find out specific information:
* Proceed as above but enter the appropriate email address in the dialog that is displayed.

Note: Fingering a host that you've fingered before is easy because Turnpike remembers previous 
addresses that you have fingered. When you want to finger one of these hosts again, simply pull down 
the list of addresses from the Finger slot of the dialog and select the address you want.



Font dialog

This dialog lets you select the combination of font, font size and font style used either when printing or 
when displaying text on the screen.

It is called up either by taking the Print Font option from the File menu or by taking the Font option from 
an Options menu.

Simply select the Font, then the Style and Size of this font you require from the set of three lists in the 
dialog.

The dialog also includes a sample piece of text so that you can see the effect of the selection you've 
made.



Function menu

Mail/News
Connect/Disconnect

Telnet
Finger
Ping
Traceroute

WWW
WS-FTP



Function menu: Connect/Disconnect

Lets you connect to / disconnect from your Access provider.

Click here for more information.



Function menu: Finger

Opens a window through which you can 'finger' other sites to see details of users at that site and other 
information available to read.



Function menu: Mail/News

Calls up the main Turnpike program so that you can, for example, see what mail messages have arrived, 
prepare further messages to send etc.



Function menu: Ping

Opens a window through which you can ping other sites in order to see whether you can get a response 
from them.



Function menu: Telnet

Opens a window through which you can log in to a remote computer eg. to search a database held there.

Click here for more information on Telnet.



Function menu: Traceroute

Opens a dialog through which you can find out about the route currently being taken between your 
computer and a given Internet address.

Click here for more information on Traceroute



Function menu: WS-FTP

Opens a window through which you can link to other sites in order to copy files from them.

Click here for more information on WS-FTP.



Function menu: WWW

Calls up the Netscape program for you to explore the World Wide Web.

Click here for further information.



Gateways
A gateway is a site on the Internet through which access is made to the Internet. Your Access provider will
either advise you directly of the addresses of the gateways you will use or they will be provided through 
the standard script for this Access provider (in which case the information may be shown as 'Automatic').



Going on-line

Click on the topic you are interested in:

Dialling up
Setting the PC's clock
Sending / Receiving mail
Collecting News
Collecting the list of newsgroups
Expiring News
Reading the mail that arrives
Accessing a remote computer
Exchanging files with a remote computer
Browsing the World Wide Web
'Errors'
Enhancing the speed of collection



Group Mail

** Of interest only on a shared system **

'Group mail' is based on 'group email names'. Mail that arrives addressed to one of these group email 
names appears in the mailbox of everyone in the group - but disappears again from everyone else's 
mailbox the moment someone processes it so there is no duplication of effort.

Group email names are simply email names with several users rather than just one. Within a company, 
you might well have names like 'sales' and 'support' set up as group email names with the members of 
your Sales team as users of the sales email name and the members of your Support department as 
users of the support email name.

For further information, see the section on 'Special features for multiple users' in the Turnpike Mail&News 
book.



Help menu

Index
Using Help
About Turnpike



Help menu: About Turnpike

Displays brief details about the version of the Turnpike program you are using - in particular, its version 
number and its date of issue.

If you want to find out about using Turnpike or about using Turnpike's Help, click on the Contents button 
at the top of this screen, then click on the topic that interests you in the list of topics displayed.



Help menu: Index

Calls up the Contents page of this Help file, from where you can access information on any aspect of 
Turnpike Connect you like.



Help menu: Using Help

Calls up a special Help file which describes using Windows Help systems such as this one.

Note: You can get Help on using Help without leaving the Help file you are currently using - by clicking on
the Contents button at the top of any display and then clicking on Using Turnpike Help.



A hex number is simply a number expressed in Base 16 (rather than the normal Base 10) with the digits 
0...9 representing 0...9 and the letters A...F representing 10...15.

It is often written with an h after the number to indicate a hex number.



Host details

Information about your Internet connection is set / inspected through the Host Configuration dialog, which 
you can call up by selecting the Host option from the Configure menu (assuming you have Connect 
Admin permission).

This dialog is automatically filled in for you with information taken either from the standard script for your 
Access provider or from information given when the Access provider was first selected. There shouldn't 
be any need to change any of the information given here.

The entries in this dialog (all of which should be filled in) are:

Domain Name: the fully-quoted domain name for your system on the Internet (as written after the @ in 
your email address)

This machine: the address of your specific machine (which will be the same as the domain name except 
on a networked system)

Organization: the name of the organisation represented by users of the system. For example this might 
be a company name or trading name, an individual's name or possibly a nickname by which you want to 
be known.

Local email: the domain over which mail can be sent without connecting to your Access provider - 
normally simply the local domain represented by your domain name.

Accept email for: the domain(s) on the Internet for which mail will be accepted by this host. It is a 
requirement of the Internet that mail is rejected if not properly intended for a site. (This will normally just 
be the domain name shown above, but you may need to accept mail addressed to other domains for 
historical reasons.)

Allow mailbox/newsstands to use other domain names: clearing this check box will stop anyone 
personalising the domain name in messages sent from this system.

Allow mailbox/newsstands to use other organization text: clearing this check box will stop anyone 
personalising the organization details quoted in messages sent from this system. 



A port (or other device)'s I/O Address is a hex number which gives its location with your computer's 
Input/Output address space.

If you need to quote a non-standard I/O address for the port to which your modem is attached, select the 
Other option then enter the required address in the Address slot alongside.

The form in which this address needs to be entered can be seen from the addresses shown in this slot 
when Com1... Com4 are selected.

Note: If a range of addresses are given for a port eg. 02F8h-02FFh, just quote the one at the bottom of 
the range ie. 2F8



IP addresses
IP addresses take the form of four-part 'dotted quad' numbers. You will either have been given your own 
IP address when you registered on the Internet or had this set for you (in which case it may be shown as 
'Automatic').



A port or other device's IRQ or 'Interrupt Request code' is a number between 0 and 15 which is used to 
label the data and instructions that are intended for that particular port or device.

The Com1 and Com2 serial ports conventionally use IRQs 4 and 3 respectively. Unfortunately, so do 
Com3 and Com4.

To avoid conflicts, each port or device that's in use has to have a different IRQ. So if you find yourself 
wanting to use Com1 and Com3 together, you either need to change one of their IRQ numbers or arrange
to use (say) Com2 and Com3 instead.



Idle timeout
The Idle timeout shown on the 'Connect to the Internet' dialog records the length of time (in seconds) that 
Turnpike is to wait for a response before alerting you to the fact that the system you are trying to talk to 
over the Internet appears to have 'gone away'.

The default setting is 120 ie. two minutes, but feel free to change this if you find you typically have to wait 
longer than this for a response - though you may then find yourself being cut off because you've 
exceeded your Access provider's standard waiting time. Demon customers, however, should note that the
waiting time they are allowed before disconnection is automatically set to two minutes (120 seconds) 
longer than the Idle timeout they set.

If no response is received in that time, Turnpike will display a message giving you the choice of timing out 
in 20 seconds or waiting for another two minutes (or whatever timeout time has been set). It is up to you 
whether to continue waiting or not.

Note: Setting the timeout time to 0 disables the timeout message. In this case the Demon disconnection 
time is set to a default of 10 minutes (600 seconds).



If you have difficulty connecting

If you experience difficulty connecting, there will probably be either an ERROR, a NO DIAL TONE, a 
BUSY or a NO CARRIER message in the Progress area of the Connect dialog.

* ERROR means your modem hasn't responded to the initialisation sequence, perhaps because it isn't 
switched on or perhaps because it isn't plugged into the correct port on your PC.
* NO DIAL TONE means that the modem hasn't been able to get a dial tone.
* BUSY means the number is engaged (though you may also get this if it is set to dial an out-of-date 
number which is now unobtainable).
* NO CARRIER means that the modem hasn't had any response from the modem's at your Access 
provider's PoP.

If it's not obvious what has gone wrong, first, turn up the volume on your modem to check that you hear 
the dialling followed by ringing and then the Access provider's equipment answering. If you don't, click on 
the Dialling button and check the settings in the Dial settings dialog. In particular, you need to check that:
* If your Access provider has a number of PoPs (Points of Presence), you've selected the appropriate 
one from the drop-down list associated with this slot.
* If you dial out through a PABX, that the requisite dial-out code is given in the PABX box. Similarly, that 
any special codes needed by the carrier you use are set in the Carrier slot.
* That the port to which you've attached your modem is selected in the Serial port area.
(Click here for further information on this.)

If you continue to have problems, contact your Access provider - who may ask you to try dialling again, 
this time with the Debug script option selected in the Connect dialog. The main window will then display 
the commands that Turnpike actually sends, from which your Access provider will be able to work out 
which (if any) of these commands need to be changed in order to dial up successfully. These changes 
need to be made to the Dialler section of your Access provider script (the .acc file in your Turnpike 
directory (a text file)) - or, possibly to your modem script (the .mdm file in your Turnpike directory (also a 
text file)).



Installing a new Access provider script

The first step in switching to a different Access provider - whether you use Turnpike to dial up your Access
provider or not - is to install the appropriate Access provider script.

The way you do this depends on whether you use Turnpike to dial.

The procedure that is available to all (or at least, to anyone with Connect Admin permission) is to take the 
Service Access option from the Connect program Configure menu, and click the New button in the 
dialog that's displayed. Alternatively, if you use Turnpike to dial (and you have Dialling Admin permission), 
you can call up the Dial Settings dialog (by clicking the Dialling button in the main Connect dialog) and 
click the New button shown alongside the Access provider slot in this dialog.

Either of these routes displays Turnpike's Internet Access Provider dialog. The main feature of this 
dialog is a drop-down list of the Access providers for which there are already scripts on your disk - to use 
when you need to update the details of the account you have with your Access provider eg. because 
you've taken out mail forwarding.

To install the script for a new Access provider, click the More button, select your new Access provider in 
the list of Access providers that is displayed, then click the Continue button.

You are then returned to the Internet Access Provider dialog which will now show your new Access 
provider in the Select access provider slot. Simply click OK from this dialog, and then work through the 
sequence of questions about your account with this Access provider.

If you called up the Internet Access Provider dialog using the Service Access route, you are then 
returned to the initial Access Provider dialog - with everything set for your new Access provider both 
here and in the other dialogs called up from the Configure menu (though it's a good idea to quickly check 
the settings that have been made). If however you called up the dialog from the Dial Settings dialog, you 
are instead returned to that dialog - ready for you to record the set of Dial Settings needed to dial up this 
Access provider at the PoP (Point of Presence) you want to use.



Internet information services

The Internet offers a wide range of other information services, such as:
* Gopher - which helps you to locate information through a series of menus.
* WAIS - which lets you search for articles on different topics by keyword.
* Archie - which can tell you where particular files are available by Anonymous FTP.

Turnpike does not support these services directly but you can access them through the Web Browser. It is
also possible to run Winsock-compliant clients for them alongside Turnpike, using Turnpike's Winsock. 
Such software is freely available on the Internet.

The other way of accessing these services is to telnet to a host which offers an appropriate client program
- but don't expect the response time to be quick.



Introduction to Turnpike Connect

Welcome to Turnpike Connect.

From this part of the Turnpike program you can:
* Go on-line to send and receive mail messages
* Download articles from the newsgroups you subscribe to
* Use the various on-line services that the Internet offers
* Browse the World Wide Web
* Consult library catalogues and databases the world over
* Pick up copies of software and other files available over the Internet
* Configure Turnpike for the Access Provider, modem etc. that you use
* Set where the mail and news files are stored

For information on any of the above topics, simply click on the topic you are interested in.

Whatever you want to do - and whichever part of the program you are using - if you need instructions, 
simply press F1 to call up this Help file. Or if you want to know about a particular option, press Shift F1 
then click on the item you're interested in. (Click here for more information about using this Help file.)



Keyboard layout choice (in Telnet)

When your PC emulates a DEC terminal for the purpose of telnetting to a remote computer, it is generally 
easier to follow the instructions you receive from the remote computer if the numeric keypad on your 
keyboard mimics the numeric keypad on a DEC keyboard which has such things as the four 
programmable function keys PF1 - PF4 on the top row of this keypad.

So Turnpike automatically selects this 'DEC layout' for your numeric keypad whenever your PC emulates 
a DEC terminal, but you can opt for the keypad keys to have their normal 'PC layout' if you prefer. (Then 
function keys F5 - F8 take on the role of PF1 - PF4.)

Alternatively, you can take the Keyboard option from the Options menu, then set the layout you require 
in the VT keyboard layout area of the dialog that's shown. (The main purpose of this dialog is to allow you 
to set up the function keys (in their various shifts) to issue commands for you: see Defining function keys.)

Click here for details of what the two options offer. 
Click here for details of the standard function key actions



Kill rules are specifications for types of articles that you don't wish to have downloaded in full.

The rules are set up through the Kill option offered in the main Turnpike program. Each rule just applies 
to the newsgroup in which it was created, giving rise to different sets of rules for each newsgroup.

When Turnpike is downloading articles from a newsgroup, it will only download the headers of those 
articles that are picked out by the corresponding set of kill rules.

For more information, call up the on-screen Help from within the main Turnpike program and search for 
Kill rules.



Leaving Turnpike Connect
To leave the Connect program, simply take the Exit option from the File menu.



Logging

If you want to record the commands and responses given while you are using any of the On-line services,
take the Log option from the File menu, then select either Log entire session or Log from here as 
required.

The various commands and responses will then be saved in a .log file (which you pick out through a File 
Selector).

When you've logged as much as you want, take the same Log option but this time select Stop logging.



Login name / Host name
This is the name which you (or your site) is known by your Access provider, and will be used to identify 
your site when you connect to the Internet. 

It is recorded in the Access Provider dialog (which is called up by taking the Service Access option from 
the Configure menu).

You should only need to change the name recorded in this dialog if your Access provider allocates you a 
new one.

Your login name is usually not regarded as confidential and so is shown in clear in this menu, but the 
password that's given alongside the login name is confidential and so is only shown as asterisks in this 
menu.



An MSD report is simply the report produced by the MSD (Microsoft Diagnostics) program supplied with 
Windows. (In Windows 95, it can be found in the \Other\Msd directory of the Windows 95 CD.)

Note: It's often best to exit from Windows before running MSD.



Mailing lists

Mailing lists do a similar job to newsgroups in that they provide people with special interests with a way of 
sending a message to everybody that shares that interest. Indeed, some Mailing lists double as 
newsgroups so that everything that's sent to the newsgroup is also sent to the Mailing list and vice versa.

The main difference from newsgroups is that Mailing lists contact people via the Internet Mail system, 
rather than via the News feed. Indeed, the reason for having Mailing lists as well as newsgroups is that 
not everyone on the Internet has access to the newsgroups. In particular, people who don't use the 
Internet directly but instead log on to a network which has a gateway to the Internet may not have access 
to the News feed.

To join (or to leave) a particular mailing list, you need to send a message to the list's administrator, telling 
him/her that you want to subscribe to (or 'unsubscribe' from) their list. The standard way of doing this is by
sending the appropriate email message to the mailing list's administrator. The messages from the mailing 
list will then be delivered to you in among the other mail you receive.

But if you have List Subscribe permission, you can get Turnpike to prepare and send these messages for 
you. Turnpike also arranges that the mail you receive from the mailing lists you subscribe to is handled 
within a special 'newsgroup', rather than mixed in with other mail. Not only does this keep items of mail 
from the mailing list separate from your other mail, but it also arranges to thread items that follow on from 
each other and to expire old items after a set time.

The steps used are carried out from the main Turnpike program'. So for further information, either call up 
the on-screen Help from within that program and search for information on Mailing lists - or study the 
section on Mailing lists in the Set-Up book.



Menus and Buttons

Turnpike Connect offers the following menus and buttons:

Toolbar
File menu
Edit menu
Configure menu
Function menu
Options menu
Snapshot
Services menu
Window menu
Help menu



Moderated groups
A moderated newsgroup is one in which contributions aren't posted directly to the newsgroup but instead 
are initially mailed to a 'moderator' who decides whether the articles are appropriate for inclusion in the 
newsgroup. This procedure improves the quality of the contributions to the newsgroup and keeps the 
discussions on target, but at the cost of a slower response rate.



Moving Turnpike to another machine/system

If you want to move Turnpike to another PC or you upgrade your PC to a different operating system, don't 
try simply copying all the old files from your old system to the new one. Instead:

1. Use the Turnpike Setup program to re-install Turnpike on the new system.

2. Copy the TURNPIKE.USR file, the NEWS directory, the MAIL directory and the USERxxx directories 
(together with any special .ACC or .MDM files you use) from the old Turnpike directory to the new one 
(replacing any already there).

3. Run both the main Turnpike program and the Connect program and check that each of these are set up
as you require (as described in the 'System Administration' section of the Turnpike Setup book).

IMPORTANT: If you are asked for your Site ID and your Site Secret, be sure to give the same ones as 
were given when Turnpike was originally installed - otherwise you won't be able to read any of the mail 
you transfer from the old set-up.



NT dial-up script
If you dial up using the Windows NT RAS, you will need to set up a dial-up script similar to the following. 
(The example given here is the one you will need if you use Demon as your Access provider. The script 
needed if you use another Access provider will probably be similar to this.)

[Demon Internet]
COMMAND=<cr>
ERROR_NO_CARRIER=<match>"NO CARRIER"

OK=<match>"ogin:"
LOOP=<ignore><cr><lf>
COMMAND=insertyourhostnamehere<cr>

 or COMMAND=olr<c>          (if about to sign up for Trial account)

OK=<match>"word:"
COMMAND=insertyourpasswordhere<cr>

 or COMMAND=olr<c>          (if about to sign up for Trial account)

ERROR_NO_CARRIER=<match>"NO CARRIER"
OK=<match>"otocol:"
COMMAND=IDLE=600,PPP<cr>

OK=<match>"PPP"
CONNECT=<match>"HELLO"

Save this as a text file called switch.inf within your RAS directory (usually c:\winnt\system32\ras)

Note: The idle=600 instruction sets the Idle timeout at your Access provider (ie. the time after which your 
Access provider will cut you off if there's no activity) to 600 seconds or 10 minutes. To set a different time, 
just replace the 600 by a required number of seconds.



NVT
NVT stands for Network Virtual Terminal. This is a very simple terminal type which any remote computer 
should be able to work with.



News service details

The News server you use (ie. the location from which you obtain Usenet news) is recorded in the 
'Configure Usenet News' dialog.

Assuming you have Connect Admin permission, you can display this dialog by taking the News 
collection option from the Configure menu on the main Turnpike Connect screen.

As well as setting the details of your News server, you can also opt to have any new news automatically 
collected (and old news expired) whenever you go on-line. For further details of the Configure Usenet 
News dialog, click here.



Newsstands are simply collections of newsgroups that each Turnpike user sets up for themselves in 
order to follow discussions on topics they are interested in. For more information, either see the Turnpike 
Mail&News book or call up the Help file from within the main Turnpike program.



The nickname provides the way of referring to a particular set of Dial Settings (as set in the Dial Settings 
dialog). If you want to record a separate set of values - in order to use Turnpike with a different Access 
provider, different modem, different speed, different carrier at certain times of day, etc. - type in a new 
nickname, change the details as required in the other slots and click on Save. 



You'll just be asked for simple information such as which Access Provider (Internet Service Provider) you 
want to use.

To start, click the Next button at the bottom of the display.

Note: If at any stage you want to review or change the information you gave on an earlier screen, use the
Back button to work back through the previous screens. Clicking Cancel to any screen is not advised as 
it will drop you out of the installation procedure. You will then have to start the whole installation procedure
again.



Enter your Site ID in the top slot. (This can be found on the CD package.)

Then enter a suitable Site Secret in the second slot.

Only click the Site Key button if you have been told a Site Key to enter.

Note: When typing the Site ID, you can use any combination of upper and lower case characters you like 
as any lower case characters will be automatically switched to upper case for you. You also don't need to 
worry whether 0 is a zero or the letter O, or 1 is the number one, a little l or a capital I: they're actually 
numbers but the letters will also be accepted.

If you need further help, click here for details of the number to ring.



Sign-on names are the names by which the different users of your system are known to Turnpike.

In broad terms, the same rules apply to sign-on names as email names because typically a user's sign-on
name will also be their principal email name. However dotted names like John.Smith may not be 
accepted here (to allow us to spot where someone has entered their domain address in this slot).

The password you give - and indeed whether you give any password - is up to you. But if you do give a 
password, DON'T FORGET THIS because without this password, you may be locked out of Turnpike for 
ever (or at least until you re-install Turnpike from scratch).

If you need further help, click here for details of the number to ring.



Demon Internet is today's largest and fastest-growing Internet provider in Europe and the market leader in
low-cost Internet access in the UK.

With the copy of Turnpike you're installing, you can also have a FREE trial of Demon Internet's service, 
which gives you:

* Full access to the Internet direct from your own computer.
* Local call access to Demon's network, which helps to cut the cost of staying on-line.
* Unlimited Email, allowing you to send and receive as much email as you like.
* Access to all the different news discussion groups (currently over 20,000) via Demon's local News 
server.
* Unlimited access to the World Wide Web.
* FREE 5M Web space
* Access to information anywhere in the world, using Demon's high-speed international links and 
modems.
* Free 24-hour, 7-days a week technical support.

So even if you have an Internet account with someone else, why not see what Demon Internet has to 
offer?

If you need any further infomation before making your selection, click here.



Turnpike asks for your full name purely so that this can be automatically included in any email messages 
or news articles you prepare.

Simply fill in the name you want Turnpike to give.

Note: This name can be changed later by taking the Configure option from the File menu in the main 
Turnpike program, then taking Users from the sub-menu that appears. For further information, either 
press [F1] to call up Help from the main Turnpike program and search for Full name, or turn to the 
section on 'Giving yourself a different sign-on name or password' in the 'Set-Up' book.

If you need further help, click here for details of the number to ring.



Your host name is the part of your demon.co.uk address immediately before the demon.co.uk. For 
example, if your demon.co.uk address is fred@anywhere.demon.co.uk, your host name would be 
anywhere

Your login password is the one you give when logging on to Demon.

If you need further help, click here for information on who to contact.



If your Access provider doesn't appear in this list, then in the first instance contact your Access provider 
and ask if they can provide a 'script' (or .ACC file) for using their service with Turnpike. If they can't, call 
Support on 0181-371 1010*.

In the meantime, however, if you won't be using Turnpike to dial, you can record the basic information 
Turnpike needs to know about your Access provider by taking the Unknown access provider option 
offered at the top of the list of Access providers.

* Calls to this number are monitored for training purposes. This information may be used for marketing purposes.



To review the answers you've given on the previous pages, click Back.

To finish this part of the procedure and go on to the next, click Finish.



This part of the Set-up procedure asks which Winsock you will be using (if there you have more than 
one). Then if this Winsock is one through which Turnpike can dial, it will ask for details of the modem you 
will be using and other dialling information.



Turnpike can be used with a range of different Winsocks (or Winsock pairs) but is easiest to use with the 
NTS Winsock (supplied with Turnpike) because it allows you to run the Connect program and go on-line 
in one smooth action. Indeed, the NTS Winsock (pair) will be selected by default if you have installed this,
so if that's what you want to use, just click Next.

But if you particularly want to use a different Winsock you have on your system, simply pick this from the 
drop-down list - though you should note that you may not then be able to use Turnpike to dial. You should 
also make a note to click the Help button when you see a message telling you that you are 'Using a third-
party WINSOCK' - for instructions on what to do.

Turnpike will automatically sort out any name conflicts that arise from your choice of Winsock (pair).

If you need further help, click here for details of the number to ring.



We generally recommend using the NTS Winsock supplied with Turnpike because this allows you to run 
Turnpike Connect and go on-line in one smooth action.

But if you have a Winsock from other software you use - such as the one provided as part of the Windows
95 Dial-Up Networking (DUN) software - it is quite OK to use that instead, though you won't then be able 
to use Turnpike to dial up. Indeed, if you have Windows NT on your machine, you will have to use eg. the 
Windows NT RAS to dial because the NTS Winsock provided with Turnpike cannot be used with Windows
NT.

If you will be using something other than the NTS Winsock, you need to ensure that the software that you 
will be using to dial is configured to dial up your Access provider NOW. Do not go any further with the 
Turnpike set-up until you have done this.

(Note: If you are in the process of signing up for a Trial account with Demon, you will need to do this 
configuration twice - first to connect to the Demon's On-line Registration facility, then again to dial in to 
Demon's standard service using your new account.)

Precisely what you need to do, of course, depends on the software you will be using but if you will be 
using the Windows 95 DUN, click here while if you will be running Turnpike under Windows NT, click here.



Simply enter the required information in each of the slots.

Note: If your modem is connected to a PABX which requires a pause between the line access code and 
the actual number, put one or more comma characters after the line access code. Each comma typically 
causes the dialler to pause for about 2 seconds.

If you need further help, click here for details of the number to ring.



Serial port: In most cases, you simply need to select the serial port to which the modem is connected - 
though you should also check that this will not interfere with any other equipment you are using, such as a
serial mouse. (If you are not sure how to go about this, click here.) But if your serial port/modem is non 
standard, you will need to select Other and fill in the address and the IRQ (Interrupt request) number it 
uses - these details should be in your hardware manual or available from your hardware supplier.

The additional Use comm.drv option selects your COMM.DRV in place of the VxD drivers of the supplied
stack. You'll only need this option if your modem doesn't include a serial chip (or equivalent) or if software 
error correction / data compression is used (WINRPI).

Serial port speed: This selects the baud rate at which the serial link will transfer information to your 
Access provider. This is not simply the speed of the modem because data compression is used which 
increases the effective transmission speed. A 14.4K modem, for example, can probably transfer at 38400 
while a 28.8K modem at 115200 (though not all Access providers support speeds that fast).

But if you find that 'errors' are reported when you connect to your Access provider, press [F1] to call up 
the on-line Help and search for Help on Errors. Then use the Dial Settings dialog to set a lower speed.

Note: If your modem is described as V.34 or V.FC it will transmit data at 28.8K baud or faster. Similarly if 
it's described as V.32 bis, it will transmit at 14.4K baud. If your modem is described as just V.32 (ie. 
without the bis) it may also be set to transmit at 14.4K, though technically V.32 implies transmission at 
9600 baud. (Note: The description V.42 or V.42 bis is no help in identifying the speed of your modem 
because this just refers to the level of error correction it does ! )

If you need further help, click here for details of the number to ring.



This Wizard takes you through a series of steps that:

* Take your name and address

* Sort out how you'll pay for your account at the end of the Trial period

* Record your choice of 'host name', 'password' and 'security phrase' to be associated with your account

* Then take you through a set of screens which get you to confirm the host name you will actually use.

Note: The basic procedure at each stage of the Wizard is to fill in the required information or make the 
appropriate selections then click the Next button. You can also use the Back button to go back to a 
previous screen, while clicking the Help button will call up further information about the selections you are
currently being asked to make. Clicking the Cancel button calls up a message which asks whether you 
really want to exit from this Online Registration procedure. If you say No, you will restart the Online 
Registration procedure from this screen but with all the information you typed before already in place so 
you can use this again.



The Wizard can only set up an account for you if you can quote the details of a valid Visa, Access or 
Mastercard credit card.

If you don't have one of these cards, you need to contact Demon's Sales Registration department directly.

Note: The request for credit card information doesn't mean that you will have use this credit card to pay at
the end of your free period. If you would prefer to pay by cheque (annual subscriptions only) or by direct 
debit, again the people to contact are Demon's Sales Registration department.



It's worth reading these terms and conditions carefully.

They are also to be found in the TERMS&C.HTM file in your Turnpike directory, which can be displayed 
and printed by Microsoft Internet Explorer or another Web browser.

If you have any questions, click here.



Select the appropriate title (Mr, Mrs, Ms etc.) from the drop-down list (or type up to 7 characters in the 
Title slot), then fill in the appropriate information in the other slots.

Note: You must fill in your Title, Surname, Address and Postcode but the other slots may be left blank. 
You are also advised to give these details in the same form as they are known to your credit card 
company (assuming that you will be using one of your own credit cards) as this will save you setting this 
information again later.

If you need further help, click here.



On this screen, you need to:

* Pick whether you would prefer to pay monthly (£11.75 a month inc. VAT) or annually (£141 per annum 
inc. VAT). Note: VAT receipts can only be issued on annual accounts.

* Enter the number and expiry date of a valid Visa, Access or Mastercard credit card - and specify 
whether it's a personal card or a company card.

If you want a particular reference number to be quoted on any invoices, you must quote it here.

If you have any questions or need further help, click here.



Check that the details shown are correct for the credit card you've opted to use. If you are using someone
else's credit card or you need to set different details for any other reason, tick the 'Different cardholder 
details' box, then make the appropriate changes to the details shown.

Then ensure that the 'Authorization' box is ticked.

Note: It's important to ensure that these details are correct. If the information you give doesn't check out, 
your free trial account will be cancelled.

If you need further help, click here.



What you need to do here is enter the Product Code supplied with the CD from which you are installing.

You can't leave this empty.



These phone numbers and extension numbers need to be given as simple strings of digits, though you 
can have spaces in the main phone numbers. You can also give the International form of the number if 
you wish (+xx....).

The phrase you select as your security phrase needs to be short (no more than 30 characters long - 
including spaces) and memorable, but not easy for someone else to guess. It will be used to identify you 
so that Demon Internet can make changes to your account over the telephone, secure in the knowledge 
that we are speaking to the account holder.

DON'T tell other people your security phrase as it will be used as proof of identity.

If you need further help, click here.



Two things are under consideration here - the 'host name' for your computer and the password associated
with your Demon account. (Note: This password is completely separate from the password you set earlier
which was for running Turnpike and its associated Connect program. Indeed, you are recommended to 
set a completely different password here because then knowing your Demon password doesn't 
automatically give access to your Turnpike files or vice versa.)

For specific advice on choosing your host name or choosing your Demon password, click the associated 
Advice button.

IMPORTANT: Make a note of the password you set.

If you need further help, click here.



Host names can be between 4 and 16 characters long.

You can use any mixture of lower-case letters, digits and hyphens except you must start with a letter and 
you mustn't end with a hyphen or have two hyphens together.

Ideally, you want a host name that clearly represents you but don't be surprised if your first name or your 
surname has already been taken.

It's worth taking care over choosing your host name because Demon will charge an administration fee for 
changing your host name later. (They also reserve the right to cancel your account if the name you 
choose is in any way offensive.)

Ultimately, you will get to pick your host name from a list of available host names that are at least similar 
to the ones you suggest, so it's a good idea to use the slots offered here for a range of possible names, 
rather than for 6 very similar ones.

If you need further help, click here.



Your password can be any mixture of 6 or more upper-case letters, lower-case letters, digits and 
punctuation marks (but not including spaces).

It needs to be something you can remember but not something that's easy for someone else to guess like
the name of someone in your family, your birthdate, or your national insurance or car number. You also 
need to avoid sequences of digits and letters that are easy to type, words picked out of even very obscure
dictionaries or simple variations of the above - because such things would be easily found by a computer 
cracker program.

What we recommend for your password is 6 - 8 characters, fitting one or more of the following 
descriptions:

* Word with unusual capitalisation
* Word with unlikely misspelling
* The first letters of a phrase.
* A phrase stripped of both spaces and vowels
* Interleaved words
* Mixture of two or more short words and digits or punctuation marks

If you need further help, click here.



If you want to check over any details before going on, use the Back button to take you back over the 
previous screens of this Wizard.



This list shows the host names you suggested, perhaps together with some other possible names.

If a host name you suggested is available for you to use, it will be ticked. If it isn't available, it will be 
marked with a cross and followed by a list of similar names which are available (possibly together with 
some similar names that aren't available so that you know not to try these).

Simply select the host name you'd like to use - or click Redo to suggest further possible host names.

IMPORTANT: Make a note of the host name you choose.

Note: It's worth taking care over choosing your host name because Demon will charge an administration 
fee for changing your host name later. (They also reserve the right to cancel your account if the name you
choose is in any way offensive.)

If you need further help, click here.



Note: It will be assumed that you have read and accepted the new terms and conditions, whether or not 
you opted to read these.



If you need further advice or help on how to fill in this page of the Wizard, you can ring 0181-371 1234* - 
any time of day, any day of the week.

* Calls to this number are monitored for training purposes. This information may be used for marketing purposes.



If you have any questions that you wish to ask about opening an account with Demon Internet...
Or you would rather not pay by credit card...
Or if you can't use this Wizard to sign up for your Free Trial eg. because you don't have a credit card or 
you don't have a UK address...
... Contact our Sales Registration department directly on 0181 371 1234*.

* Calls to this number are monitored for training purposes. This information may be used for marketing purposes.



Click OK, then select from the displayed list by clicking on the appropriate entry.

If you don't know which entry to select, click the Help button shown below the list.



Correct what you typed, then try again.



You must supply at least one phone number on which you can be contacted.



You must give both the number and the expiry date of a credit card, and indicate whether it is a personal 
card or a company card.

This card must be either Visa, Access or Mastercard and it mustn't be due to expire before the end of 
your free period.

Note: This card doesn't have to be yours and you won't necessarily have to pay your Demon subscription
using this card. If you would prefer to pay by cheque (annual subscriptions only) or by direct debit, click 
here.



You must give at least the card holder's Title, Surname, Address and Postcode - all as known to the 
relevant credit card company.



Only expiry dates from the current date to 10 years hence are acceptable. Other dates are assumed to 
have been given in error.



A suitable host name is between 4 and 16 characters long and you need to suggest at least one.

You can use any mixture of lower-case letters, hyphens and digits but you must start with a letter and you 
mustn't end with a hyphen or have two hyphens together. You also can't include any spaces.



You must set a logon password, made up of at least 6 ASCII characters (no spaces).

Click here for advice on choosing a good password.



You must choose between paying monthly (£10+VAT a month) or paying annually (£120+VAT a year) and 
quote the details of a credit card that could be used to pay your Demon subscription, though you don't 
necessarily have to use this card to pay. If you would prefer to pay by cheque (annual subscriptions only) 
or by direct debit, click here.

You must also click the 'Authorization' box below the card holder's details to confirm that Demon can debit
this card if no other payment details have been received by the time payment becomes due.



You must give at least a Title, a Surname, two lines of Address and a Postcode.

Note: If the appropriate title isn't included in the drop down list, select Other, then fill in the required title 
(in no more than 7 characters) in the adjacent box. Don't simply select the Other option !



Phone numbers inside the UK should normally be given as a simple sequence of digits though you can 
include spaces, hyphens and parentheses (though not in extension numbers).

Numbers outside the UK should be given in the standard 'International' form of a + then the country code, 
followed by the appropriate number.

Check that you typed the number correctly.



Valid postcodes for the UK:
* Start with either one or two letters, followed by one or two digits
* Then have a space
* Followed by a single digit and two letters

Check the post code has this form - and that you typed the letters you meant.

* If you don't know your postcode or you live abroad, click here.



The phrase you select as your security phrase needs to be short (no more than 30 characters long - 
including spaces) and memorable, but not easy for someone else to guess. It will be used to identify you 
so that Demon Internet can make changes to your account over the telephone, secure in the knowledge 
that we are speaking to the account holder.

Don't tell other people your security phrase as it will be used as proof of identity.



To resolve this, you need to re-install Turnpike.



If you really want to abandon Online Registration, click Yes.

But if you simply want to review or change information you entered earlier, click No. You will then return to
the very first screen of this Online Registration Wizard, but with the information you entered earlier all 
intact so you can simply work through making the changes you need.



Options menu

The Options menu lets you set some aspects of how your PC displays information and responds to your 
commands. The options are:

Font
Colour

Emulation (Telnet only)
Keyboard (Telnet only)



Options menu: Colour

Displays a Colour Selection dialog from which you can select some of the colours used to display text on 
your screen.

For information about the Colour Selection dialog, either click here
or press F1 to call up this Help file when you have this dialog on the screen



Options menu: Font

Displays a Font dialog from which you can select the typeface and typesize (and typestyle) used to 
display commands and responses on the screen.

Note: This option only sets the font used for display. The font used when printing is set through the Print 
font option in the File menu.



If you dial up via a PABX/switchboard and need to dial any special digits for an outside line, you need to 
enter these special digits in the PABX (line access) slot of the Dial Settings dialog.

If a delay is needed before sending the rest of the number, you will need to follow these digits by a further 
special character. The character to use depends on your modem, but most modems take a comma to 
mean a delay of about a second.



POP3 Server option
The POP3 Server options included in Turnpike allow users to access the mail in their Turnpike mailbox 
from outside their Turnpike system - either from a copy of Turnpike running on a machine that doesn't 
have direct access to your mailbase or from another mailreader.

This is a specialist facility intended for use in an office where mail for everyone in the company is 
collected using Turnpike but people don't necessarily always want to use Turnpike to read their mail.

It is not intended for use on a single-machine dial-up system. For a start, it requires the Connect program 
to be running whenever anyone wants to use this facility. Moreover, it requires a live TCP/IP connection 
between the machine on which Connect is running and the machine from which the mailbox is accessed.

You should also note that it opens a route whereby people from outside the company could potentially 
access users' mail. For this reason, the facility has to be specifically enabled (either through the Services 
menu POP3 Server   option   or through the 'Enable POP3 Server' option in the Configure Email dialog). It 
also has to be specifically enabled for each individual user who is allowed to access their mailbox in this 
way (by giving them Serve POP3 permission within the main Turnpike program's Configure Users dialog).

In addition, the system requires any user wishing to access their mail in this way to give their Turnpike 
sign-on password.

You are strongly advised to ensure that any users for whom this facility is turned on don't have a blank 
password, because that would make it just too easy for someone outside the company to impersonate 
them.



Passwords
A number of actions require you to give the appropriate password. Depending on the circumstances, you 
will either have had this password set for you (eg. by your system administrator), agreed it with your 
Access provider or set it yourself the first time you used the particular facility.

For security, whenever you type a password the screen simply shows * characters representing each 
actual character of the password, while dialogs which include passwords just show a block of asterisks 
the length of which bears no relation to the actual number of characters in the password.

Note: Most passwords can simply be changed within the dialog in which they are displayed. But when 
you want to change the password associated with the account you have at your Access provider, you 
need to change this both at your Access provider (using whatever steps they tell you to follow) and in the 
Access Provider dialog within Turnpike Connect.



Permission
The idea of 'permission' only really applies to systems shared by a number of users. On such a system, 
whoever takes the role of System Administrator can set a list of actions that individual users have 
'permission' to do without reference to the System Administrator. Click here for details of both the 
permissions that can be given and the actions they control.

The permissions are set through the main Turnpike program, as part of the 'Configure Users' and 
'Configure Workgroups' procedures. So for more information, either press F1 to call up Help from within 
the main Turnpike program or turn to the section on Setting permissions in the 'Set-Up' book.

Note: If you don't have permission to carry out a particular action, you'll find the corresponding options 
greyed out.



Pinging

The Ping feature allows you to test whether a particular computer on the Internet is up and running.

Almost all machines will respond to a ping, so if you don't get a response it means that either:
* The computer is switched off
* Something within either the Internet itself or your connection to the Internet (ie. your phone link or your 
Access provider) is broken
* You're not giving the correct machine name.

Ping is therefore very useful in troubleshooting.

To ping a computer from Turnpike:
* Click on the Ping button.
* Enter the computer's Domain name in the dialog that is displayed. (Note: This domain name needs to be
given in full, even where you are pinging one of your Access provider's sites.)
* Click the Ping! button.

Notes: (i) Pinging a computer that you've pinged before is easy because Turnpike remembers the 
addresses of previous sites that you have pinged. When you want to ping one of these hosts again, 
simply pull down the list of addresses from the Ping slot of the dialog and select the address you want.

(ii) If you are using Ping to discover where a problem lies, use the computer's dotted-quad IP address if 
possible in place of its domain name. Then the test you make won't involve the Domain Name Server.

Your Access provider should be able to help you if you do not know the domain name or IP address for 
pinging.



Posting News

Any news articles that have been prepared are sent alongside any mail messages that are waiting to be 
sent. So for further information, see Sending / Receiving Mail.



Print Preview toolbar

Print Prints the display that you are currently previewing.

Next Page / Prev Page Allow you to step page-by-page through the display you are previewing.

One Page / Two Page Switches between a Single-page and a Two-page view. (Note: Only available at 
the lowest zoom level.)

Zoom In / Zoom Out Allow you to see the display at different zoom levels.

Close Closes the Preview display.



Print Setup dialog

Taking the Print Setup option from the File menu displays a standard Windows Print Setup dialog 
through which you can set the printer and paper you use.

The main features of the dialog are:

Printer: Select either your Default printer or a specific printer as you require.

Paper: Selected from a drop-down list.

Orientation: Select either Portrait (paper used lengthways) or Landscape (paper used widthways) as 
required.

Options button: Click this button to call up a further dialog in which you can set more advanced features 
such as printing to a file and duplex printing (if your printer supports this).



Print dialog

Taking the Print option from the File menu in order to print a message or an article displays a standard 
Windows Print dialog through which you can set such things as the number of copies you want.

The main features of the dialog are:

Printer: This entry shows your current printer. (If you want to use a different printer, click the Setup 
button.)

Print Range: Through which you can specify that you want to print either the whole message/article or a 
range of pages. (You can find out how a message or article divides into pages by previewing it.)

Setup button: Click this button to check or change the printer or paper you will use.

Copies: Set the number of copies you want here.



You will need to re-run Turnpike Connect and complete this initial configuration before you can use any of 
the Connect program's facilities.



The action you are trying to take is contrary to the access that's allowed to the object you are trying to 
process. You may, for example, be trying to write to a read-only file or to open a directory as a file.

You probably need to select a different filename.



Either you've tried to combine files from different versions or from different users, or this file has become 
corrupted.

Make a back-up of the important files in your system - separate from any previous back-up you've taken - 
then try to sort the problem out, for example by restoring files from a previous back-up or, if a datafile has 
been corrupted, by rebuilding the affected file (from the main Turnpike program).



Check the COM Port settings in the Dial Settings dialog against the ones in the Windows Control Panel 
and the MSD report.

There's a mismatch somewhere.



You need to ensure that all copies of the Turnpike program are shut before you can re-build this datafile.



There is a problem with the application that you are trying to run.

Check that the path details are correct and that this application is correctly installed.



Either email info@turnpike.com or phone Turnpike Support on 0181-371 1010* with details of your 
Site ID (which you can find out by editing the CONNECT.INI file in your Turnpike directory).

* Calls to 0181-371 1010 may be monitored for training purposes. This information may be used for marketing purposes.



The datafile(s) needs to be rebuilt.

To rebuild the files, either the System administrator or another user with Rebuild files permission needs to 
take the Rebuild database option form the File menu and follow the instructions on the screen.

Note: Rebuilding these files may take some time.



This file has either been deleted or it has become damaged in some way.

You probably need to re-install Turnpike.



This is a system-level problem.

For a detailed explanation, look up the error message in the information on 'DOS errors' or 'System errors'
(or just 'Errors') in the documentation supplied with your machine or with the operating system you are 
using.



The chances are your mail/news files have been moved but this move hasn't been recorded in the File 
Paths dialog.

To sort this out, click OK: then back in the Sign-on dialog, click the Paths button to display the File Paths 
dialog and check that the correct directories are selected.

If necessary, use the Windows File Manager / Explorer to check the location of:

      * Your TURNPIKE.USR file (the Server path - probably a TURNPIKE directory)

      * Your MAILBASE, MSPOOL and ADDRBOOK files (the Email path - probably a MAIL directory)

      * Your NEWSBASE and NSPOOL files (the News path - probably a NEWS directory)



Turnpike has kept the previous version of this file (suitably renamed) in case you added any special 
features to it which you want to copy over into the new file.

If you didn't change the previous version or the change you made is no longer needed, click the Delete 
original button. There's no point keeping the earlier version of a file unless it contains special information 
you need to copy to the new file.



The Trial version of Turnpike you are using can only be used in conjunction with a Demon account.

If you have a Demon account, take Service Access from the Configure menu and use the Access 
Provider dialog that is displayed to select your Demon account.

If you don't have a Demon account and you want to continue using Turnpike, you will need to buy a full 
copy of Turnpike. For further information, contact Demon Sales on 0181-371 1234*

* Calls to 0181-371 1234 are monitored for training purposes. This information may be used for marketing purposes.



To correct this problem, you need to leave not just the current program but any other applications that you
are currently running and edit your SYSTEM.INI file - which you will find in your C:\WINDOWS directory. 
(If you are not at all sure how to go about this, click here if you are using Windows 95 - or here if you use 
Windows 3.1 or similar.)

When this file is displayed, find the section headed [386Enh] and check that this contains three device= 
lines as follows:

If you are using Windows 3.x, you should have the lines:
                device=c:\turnpike\vntstimd.exe
                device=c:\turnpike\vtcprac.386
                device=c:\turnpike\vntspsd.386

If you are using Windows 95, you should have the lines:
                device=c:\turnpike\vntstimd.vxd
                device=c:\turnpike\vtcprac.386
                device=c:\turnpike\vntspsd.386

Any duplicates or other variants of these lines should be deleted.

Save your changes, then restart Windows and run the Connect program included in the Turnpike 
folder/program group.

Note: These instructions assume you installed Turnpike in the root of your C: drive. If you installed it 
somewhere else, you will need modify these device= lines accordingly.



You've left the slot for the specified information blank. This must be filled in.

Click here for further information about the Dial Settings dialog.



You are strongly recommended to switch to the Windows File Manager / Explorer and make some space 
available on the drive named in the message. Having made space, you should then return to the 
message and click the Retry button.

Doing anything else is not recommended.



This is a disk/drive problem.

If it's obvious to you what you need to do to correct the problem, look up the error message in the 
information on 'DOS errors' or 'System errors' (or just 'Errors') in the documentation supplied with your 
machine or with the operating system you are using.



The Evaluation version gives access to the Internet for 30 days, with an optional 15-day extension for 
anyone ordering a full copy of Turnpike before the Connect program 'expires'. (To order your full copy of 
Turnpike, ring Demon Sales on 0181-371 1234*)

If the program expires before your full Turnpike package arrives, either email info@turnpike.com (if you 
can) or phone Turnpike Support on 0181-371 1010* with details of your Site ID (which you can find by 
editing the CONNECT.INI file in your TURNPIKE directory). They should then be able to provide you with 
a 'Site Key' to unlock your copy of Turnpike.

* Calls to 0181-371 1010 and 0181-371 1234 may be monitored for training purposes. This information may be used for marketing 
purposes.



There is a serious problem with this database. You probably need to replace it with your back-up copy.

Important: Replace NEWSBASE and NSPOOL together; similarly replace ADDRBOOK, MAILBASE and 
MSPOOL together.



Check the file details you are giving. They are probably out of date.



If you are doing this deliberately, fair enough - but otherwise you are missing out on a couple of features 
quite unnecessarily.

You can pick up a full version by FTP from:
       //ftp.demon.co.uk/pub/mirrors/turnpike/

Note: The files are quite big, so different 'flavours' are offered, covering the choice of 'Windows 3.x' 
version (for 16bit systems) or 'Windows 95' version (for 32bit systems), with or without Microsoft Internet 
Explorer. Study the Readme file in the directory for information on which file you need to copy.



You probably need to close some of the other applications you are currently running.

It may even be a good idea to restart Windows.



Call up the Dial Settings dialog and re-select your Access provider and your modem.



Call up the 'Configure Email' dialog and check that the address given for the Mail gateway is correct.

If necessary, re-install your Access provider.



The script for your current Access provider (.ACC file) / your modem (.MDM file) has been modified in 
such a way that it no longer has the correct format.

If possible, replace it with a back-up copy of the unmodified file.



Restore the settings you changed in the Connect.ini file eg. by going back to your back-up copy of this 
file.



Turnpike is unable to handle this file.

Are you sure you picked the file you meant? Are you sure it is a text file?



To start with, the lost seat is assigned to userxxx where xxx represents a number.

To access the files associated with this seat, the System Administrator or someone else with Configure 
Users permission needs to go into the main Turnpike program, call up the 'Configure Users' dialog and 
edit the userxxx entry to give it a suitable sign-on name and password.

The files can then be inspected by someone signing on using this sign-on name and password.



Simply pick the option you prefer.



Check that you are using the files you intend, then rebuild the relevant datafile.

Note: If you replace any files from backup copies, be sure to replace the NEWSBASE and NSPOOL files 
together and the MAILBASE, MSPOOL and ADDRBOOK files together. Don't try to combine files from 
different back-up sets.



Consult your system administrator.



Either SHARE or VSHARE was available on your machine when Turnpike was installed.

If you don't know how to re-enable it, consult your System Administrator.



On clicking OK, you'll exit from this program. You'll then need to run the Connect program and select a 
Winsock to use (when asked to do this), or to sort out a Winsock for yourself.

You won't be able to use Turnpike Connect until you have selected the Winsock to use.



This isn't a problem if you are only going to use 16bit applications like the built-in Ping, Finger and Telnet 
alongside the Connect program, but if you want to use Internet Explorer 3.0, WS-FTP or any other 32bit 
applications alongside Connect you need to install a pair of 16 and 32bit Winsocks, such as the NTS ones
provided alongside Turnpike.

To install the NTS Winsocks, run the Turnpike Setup program, take the Custom option and arrange that 
just the Winsock is selected for installation.



This message has been displayed for your advice. There isn't necessarily any problem for you to sort out.



Either pick a different set of connection details in the Connection slot of the Connect dialog or click the 
Dialling button and set new details in the Dial Settings dialog.



If you get a message saying that the phone line has dropped and offering to redial, it usually means that 
the phone line has indeed dropped - because of an idle timeout at your Access provider, a noisy line, 
someone picking up an extension or through call notification breaking in. If you have an external modem, 
you will be able to confirm this by looking at the lights on the modem.

If you find that you are often losing your connection to your Access provider in this way, it is worth 
checking both the quality of your phone line with your telephone provider and that you haven't got call 
notification (or any such similar service) turned on.

Sometimes, however, the phone line has not dropped. This usually means that there is a fault in the cable
which joins your machine and the modem. More rarely it will be a problem with the COM port on your 
machine or on the modem itself. The easiest way to locate such a problem is by replacing each 
component in turn by another of the same type until you find where the problem lies.



Click the Yes button to continue or the No button to cancel.



Re-install your Access provider.



The database files need to be rebuilt to incorporate the new information, and wherever possible, Turnpike 
offers the chance of doing this now. But as this will take some time, Turnpike offers the option of leaving 
the database files as they are by clicking the No button. However you won't then get the changes.

Database files can also be rebuilt by taking the Rebuild database option from the File menu - assuming 
you have Rebuild files permission.



You can opt not to restart Windows when Turnpike advises you that this needs to be done (for example, 
because you have other applications running), but you must restart Windows before you next try to 
run the Turnpike Connect program. The Connect program will not be able to run until you have 
restarted Windows.



We recommend shutting down all applications and restarting Windows.



To sort this problem out, the System Administrator or some other user with Configure Users permission 
needs to call up the Configure Users dialog within the main Turnpike program.



You need to choose at least one from the supplied list - but no more than five.



The file you are trying to access is being used by another application - possibly on another machine if 
your computer is on a network.



An error has occurred in the program.

Please email internet@demon.net with details of the message seen and the circumstances under which 
this message appeared.



Sorry, this feature has not been implemented yet.



Click OK then click the Disconnect button at the left-hand end of the toolbar before trying to shut the 
Connect program again.



Exit from the program as 'gracefully' as you can, then restart.

It may also be a good idea to restart Windows.



Clicking Yes will tell Turnpike to close all the open clients then disconnect.

Clicking No will allow you to ensure that you've really finished with these clients before disconnecting.



The Winsock you are using is not one through which Turnpike can dial.

If you are not already connected to the Internet, leave this message on the screen for the moment and 
switch to whatever software you usually use to connect to your Access provider. Once you are connected,
promptly switch back to Turnpike and allow it to continue by clicking the Connect now button.

Note: If you are planning to use the Windows 95 DUN to dial up, don't even think about connecting until 
you followed the instructions in the READW95.DOC document which has been installed alongside the 
Turnpike files.

This is particularly important if you are in the process of dialling up to register for a Trial account with 
Demon Internet, because it tells you precisely what you need to do - down to the level of which login 
name and login password you need to use.



With the standard 'single-access' version of Turnpike, you can only have one copy of the Connect 
program and one copy of the Turnpike program running at any time - though not necessarily always from 
the same machine. With the 'multi-access' version, you still can only run one copy of Connect but you can
have multiple copies of the Turnpike program running, up to the number of seats purchased.



Are you sure about what you are trying to insert ?

As you've triggered this message, the chances are that what you are trying to do won't work anyway.



Check the details that were supplied to you by your Access provider, then try again.



There's something wrong with the way the button that calls up this program is configured. The chances 
are that the program has been moved but the Toolbar information hasn't been updated to match.

Take Toolbar buttons from the Configure menu and use the Toolbar configuration dialog that's displayed
to ensure that the details recorded for this program are correct.



There is something unusual about this Winsock which has meant that Turnpike's 'Switch Winsock' 
mechanism couldn't give it a standard WINSOCK/WSOCK32 name. The name of the file itself may be 
enough to tell you what the problem is.

You will need to rename it yourself to something suitable.



The problem is probably that you're trying to use an old Winsock that doesn't support the full range of 
functions.

You need to arrange to run a more recent Winsock - for example, by installing the NTS Winsock supplied 
with Turnpike. (To do this, run the Turnpike Setup program, take the Custom option and arrange that just 
the Winsock is selected for installation.)



To be used together, the 16bit Winsock WINSOCK.DLL and 32bit Winsock WSOCK32.DLL files on your 
machine need to be a pair eg. both NTS Winsocks or both Microsoft Winsocks. However, it doesn't matter
if they don't match unless you want to run any 32bit applications alongside Turnpike such as Microsoft 
Internet Explorer 3.0, 32bit versions of Netscape or the WS-FTP supplied for use under Windows 95.

If you know you won't be running any 32bit applications you can opt to continue with the Winsocks you 
have. Otherwise, click the Change Winsocks button and use the dialog that's displayed to pick out a 
suitable pair of Winsocks to use.



If you are uncertain how to proceed, contact your Access provider for advice.

Note: If connection is refused to something like your Access provider's news service, the service you are 
trying to use is probably off-line at present. There may be a way of getting status information on such 
services. For example, Demon customers can finger status@gate.demon.co.uk.



The characters that are being received suggest that you are probably using the wrong emulation eg. 
ASCII instead of NVT or NVT instead of one of the DEC terminal emulations - VT100 or VT52.

You can either switch to this emulation now by clicking the appropriate button. Or you can continue using 
your current emulation if you know that what was received wasn't what it appeared to be.



Click OK to return to the Sign-on dialog and enter the correct information.

If you don't know or can't remember either your sign-on name or your password, consult your System 
Administrator or some other user who has Configure Users permission. They should be able to tell you 
what your sign-on name is and to set a new password for you. Once you've signed on using this 
password, you'll be able to set a new password for yourself by running the main Turnpike program, 
selecting Configure | Users from the File menu and setting this in the Edit sign-on details dialog that is 
displayed.



The file you are trying to use was created on an incompatible Turnpike system. At the time of writing, no 
such system existed but it is always possible that one could have subsequently been created.

If you have access to a newer version of Turnpike, try using that.



Reading/Preparing mail or news

If you want to read the mail and news that arrives - or to prepare new messages to send out - click the 
Mail/News button.

This calls up the main Turnpike program through which you can read messages, prepare new messages 
etc. etc.

Turnpike Connect stays running - so you can return to this program whenever you want eg. by using Alt 
Tab to switch between the applications currently open on your screen. 



Rebuilding mailbase etc

The main purpose of Tunpike's Re-build option is to recover wasted disk space left in your newsbase, 
mailbase or address book after earlier entries have been erased. But it can also be used to recover these 
if they should become corrupted (or at least as much of possible of these).

Assuming you have Rebuild Files permission, you can re-build any of these files by taking the Re-build 
database option from the File menu and then picking Mail, Address Book or News as appropriate from 
the message that is displayed (or Cancel if you decide not to rebuild any files after all). Turnpike then 
builds a new version containing just the current information from the old version - recovering both wasted 
disk space and as much as possible of the information from the old files.

Note: Although rebuilding a database will usually recover all your email messages or news articles, there 
is no guarantee that this will always be possible. You are strongly advised to keep up-to-date backups of 
all these databases: see Backing up your Turnpike files.



Recording how you dial up

Details of the phone number etc. that you will be using to dial up your Access provider are all recorded in 
the Dial Settings dialog, which you can call up by clicking the Dialling button within the main Connect 
dialog (assuming you have Dialling Admin permission).

This dialog gives a complete specification of how you will be dialling - which Access provider you will be 
using; what number needs to be dialled (and whether tone or pulse dialling is required); which modem; 
which port on the PC this modem is attached to; and what transfer speed is to be used.

You simply need to work round the dialog, setting the required information in each section - then save this
set of 'Dial Settings' under a suitable nickname which is recorded at the top of the dialog. (This 
association of a nickname with a set of Dial Settings allows you to set up more than one set of Dial 
Settings which you can select at will, simply by picking the appropriate nickname from the drop-down list 
offered in the main Connect dialog.)

To record a new set of Dial Settings, set a new nickname at the top of the Dial Settings dialog then click 
the Save button. To replace an existing set of Dial Settings, select the appropriate nickname from the 
drop-drop list first, make your changes, then click the Save button.

Click here for further information about the Dial Settings dialog



Running other Winsock applications

Other applications which use a Winsock can be run while Turnpike is on-line - for example alternative FTP
programs or WWW browsers.

Many "shareware" applications are available over the Internet using FTP.

To use such an application, you will need to install the application as an icon on your Windows desktop in 
the usual way. If you have difficulty doing this, you will need to consult the supplier of the application.

To run the application, start Turnpike Connect and Connect to your Access provider in the usual way, then
return to the Windows Program Manager and simply double click on the icon for the other Winsock 
application.



Running under Windows NT
Turnpike works fine under Windows NT but the NTS stack provided with Turnpike cannot be used with 
Windows NT. This means you will need some other Winsock and some other way of dialling up the 
Internet.

An outline of the steps you need to take to use Windows NT's Remote Access Service (RAS) for this are 
given below.

First you need to install the RAS software and the TCP/IP protocol on your machine (if you've not already 
done this). Do this through the Control Panel, Networks 'Add software' option.

Make sure that the RAS is configured to have TCP/IP as a dial-out protocol.

You also need to select the TCP/IP protocol Configure option, pick DNS and set your host, domain and 
the DNS servers you will be using. If you are about to sign up for a Trial account with Demon, you need to
give olr as the Host, demon.co.uk as the Domain, and 158.152.1.58 and 158.152.1.43 as the DNS 
Servers. In other cases, you can find out the addresses you need by running the Turnpike Connect 
program and taking the Service access option from the Configure menu.

You then need to save the appropriate dial-up script for the service you intend to use. (Note: If you are 
signing up for a Trial account with Demon, you will need to edit this file after you've signed up to record 
the hostname and password you set up for your Trial account.)

Last but not least, you need to set up the Edit Phonebook dialog as follows:

On the 'Basic' page of this dialog, you need to set a name for the service you will be dialling (eg. Demon 
Internet), enter the phone number you will be dialling (0845 353 5666 if you are about to sign up for a 
Demon Trial account) and select the modem you will be using from the list of modems installed on your 
machine. For contacting Demon, you also need to check that this modem is configured to enable 
hardware flow control, plus modem error control and modem compression if your modem supports these.

On the Server page, select PPP as your dial-up server type and TCP/IP (suitably configured for your 
Access provider) as the network protocol. For contacting Demon, you should configure the TCP/IP to 
take a server-assigned IP address (nb. essential if you're about to sign up for a Trial account), set 
158.152.1.58 and 158.152.1.43 as the DNS Servers (as above) and opt to use VJ Header Compression 
and the Default gateway on the remote network. You also need to take the Enable PPP LCP extensions 
option if you use Demon.

On the Script page, click Refresh list (to make your new script available), then pick out your script from 
the list of scripts offered to run.

On the Security page, select the option to Accept any authentication including clear text, and click the 
Unsave password option (if offered).



Select Access provider dialog

This dialog is displayed when you install a new Access provider.

Simply select the Access provider you want to install from the list offered in the dialog, then click the 
Continue button.

Note: If this dialog doesn't cover the Access provider you require, replace the ACCESS.TPK file on your 
system by a copy of the latest ACCESS.TPK file, then try again. (You can pick up a copy of this file by 
FTP for example from the Demon pub/mirrors //ftp.demon.co.uk/pub/mirrors/turnpike/scripts/ 
directory. Precisely what you need to do will be explained in the Readme file included in this directory.)

If your Access provider isn't included here either, contact your Access provider. If they can't help you with 
a suitable script, call Turnpike Support. In the meantime, however, if you don't use Turnpike to dial, you 
can record the basic information Turnpike needs to know about your Access provider by taking the 
Unknown access provider option offered at the top of the list of Access providers.



Select Winsock dialog

This dialog shows which 16bit Winsock (and on Windows 95, which 32bit Winsock) is currently selected 
and allows you to pick a different Winsock (or pair of Winsocks) to use (if you have more than one).

It is displayed by taking the Winsock used option from the Configure menu (assuming you have 
Connect Admin permission).

The lower part of the dialog shows the Winsock(s) that your system is currently set up to use. To switch to
a different Winsock/Winsock pair, select the one you want to use instead from the drop-down list offered 
at the top of the dialog. Turnpike then ensures that these Winsocks are named WINSOCK.DLL (16bit) 
and WSOCK32.DLL (32bit) while any conflicting Winsock files are suitably renamed.



Select modem dialog

This dialog is displayed by clicking the New button shown alongside the Modem slot within the Dial 
Settings dialog.

Simply pick out your modem from the list, then click the Continue button.

Note: If your modem isn't listed or if you aren't sure which modem to pick, either click here or click the 
Help button shown alongside the list for further advice.



Sending / Receiving mail

When you go on-line, you will probably want both to send any mail messages or news articles that are 
sitting in an Out tray and to receive any mail that has been sent to you.

The default is for both of these actions to be carried out automatically whenever you go on-line but, if you 
want, you can arrange that either or both of these actions is only carried out when you prompt this 
(assuming that you have Connect Admin permission).

The way to do this is to select Mail transfer from the Configure menu on the main Turnpike Connect 
screen. If mail is being sent and received automatically, the 'Send automatically' and 'Receive 
automatically' boxes in this dialog will be checked. To keep either action under your control, clear the 
corresponding automatic option. You can then just use the Send mail /Receive mail options in the the 
Services menu to select these actions when you need them.

While the mail is being transferred, you will see messages in status bars at the bottom of the screen 
recording how many items are expected, how many have been sent etc. There will also be a status bar 
showing information about the rate at which data is currently being transferred (in cps) and reporting 
errors (overruns) in this transmission. If you get a lot of errors, disconnect then re-connect but only after 
you've read the section of this Help file on Errors and set a lower speed in the Dial Settings dialog. You 
are currently trying to pick up data faster than your PC's serial port is able to handle it.



Sending commands line by line (in Telnet)

When you telnet to a remote computer, the commands you issue will normally be sent character-by-
character, but if your computer is emulating either an NVT or a simple ASCII terminal, these commands 
can also be sent line-by-line.

Line-by-line is often preferred to character-by-character because it allows you to edit your commands 
before they are sent. It also avoids the character-echoing effect you can get when commands are sent 
character-by-character.

To arrange that commands are sent line-by-line, take the Emulation option from the Options menu, then 
check the Buffer lines box in the dialog that's displayed.



Services menu

Selects services to be executed when you go on-line.

Collect News
Expire News
Send Mail
Receive Mail
POP3 Server
Set the PC Time



Services menu: Collect News

When this option is ticked, new news articles will be downloaded from your news server when you go on-
line. In addition, any articles you've written will be posted.

The initial setting of this option depends on the setting of the Automatic collection option within the 
'Configure Usenet News'     dialog   (which you can call up by taking the News collection option from the 
Configure menu - assuming you have Connect Admin permission).

Note: Selecting the Collect News option toggles its setting between ticked and unticked. Doing this while
news is being collected will stop the current collection.



Services menu: Expire News

Prompts Turnpike to erase from your disk those news articles which have passed their expiry date.

The initial setting of this option depends on the setting of the Automatic expiry option within the 
'Configure Usenet News'     dialog   (which you can call up by taking the News collection option from the 
Configure menu - assuming you have Connect Admin permission).

Note: Selecting the Expire News option toggles its setting between ticked and unticked.



Services menu: POP3 Server

Enables the facility whereby users of your system can access their mailboxes from outside Turnpike.

Note: This option should not be selected lightly as it opens a route whereby people from outside could 
access your users' mail. (For further information, see POP3 Server option.)

Note: Selecting the POP3 Server option toggles its setting between ticked and unticked.



Services menu: Receive Mail

When this option is ticked, any mail waiting at your mail gateway will be delivered when you go on-line.

The initial setting of this option depends on the setting of the Receive automatically option within the 
'Configure Email'     dialog   (which you can call up by taking the Email transfer option from the Configure 
menu - assuming you have Connect Admin permission).

Note: Selecting the Receive Mail option toggles its setting between ticked and unticked. Doing this while 
mail is being received will stop the current collection. If mail was being fetched from a POP mailbox, you 
may get a second copy of some of this mail the next time your mail is picked up.



Services menu: Send Mail

When this option is ticked, any mail messages waiting in an Out tray will be sent when you go on-line.

The initial setting of this option depends on the setting of the Send automatically option within the 
'Configure Email'     dialog   (which you can call up by taking the Email transfer option from the Configure 
menu - assuming you have Connect Admin permission).

Note: Selecting the Send Mail option toggles its setting between ticked and unticked. Doing this while 
mail is being sent will halt the transfer of mail.



Services menu: Set the PC Time

Sets the clock on your PC from one of the Time servers on the Internet - allowing for the Timezone you 
work in.

The initial setting of this option depends on the setting of the Automatically set PC clock option within 
the 'Timezone dialog (which you can display by taking the Email transfer option from the Configure 
menu - assuming you have Connect Admin permission).

Note: Selecting the Set PC Time option toggles its setting between ticked and unticked.



Setting passwords

When you sign on, you need to use whatever password is currently set for you - but after you have signed
on, you can give yourself a different password if you like.

In addition, on a shared system, someone with suitable administrative powers can set a different 
password for another user - for example, to let this user back into the system after they can't remember 
their current password.

New passwords are set from the main Turnpike program. You need to select Configure from the File 
menu of that program, then pick Users from the submenu that appears.

System administrators go first to a list of users, from which you need to select the appropriate entry and 
then click the Edit button. You can then set a new password in the Edit Sign-on details dialog that 
appears.

Non-administrators go straight to their version of the Edit Sign-on details dialog in which you can set a 
new password for yourself.

If you don't feel you need to protect your mail through a password, give yourself a blank password. You 
can then also opt to disable Turnpike's Sign-on dialog as well.

For further information, either press F1 to call up Help from the Edit Sign-on details dialog or turn to the 
section on 'Giving yourself a different sign-on name or password' in the 'Set-Up' book.



Setting permissions

Where a number of people share the same system, it is generally best to have just one user - or at most a
handful of users - responsible for administrative tasks like allocating users to seats, choosing which 
newsgroups are subscribed to and how long these stay on your disk etc.

The way this is handled in Turnpike is by associating a range of 'permissions' with each user.

The permissions that someone has can either be set directly for that person or they can come through the
workgroup(s) of which they are a member. 

In either case, the setting is made within the the main Turnpike program. Personal permissions are set 
through 'Edit sign-on details' dialog that is used to set the user's sign-on name and password. 
Workgroups permissions are set through the 'Edit workgroup details' dialog that is used to specify the 
members of the workgroup. In each case, someone with the appropriate permission to select the actions 
that the user is to be able to do without reference to the system administrator.

For further information, either press F1 to call up Help from the main Turnpike program and search for 
'Permissions' or turn to the section on 'Setting permissions' in the 'Set-Up' book.



Setting the Timezone

Because different parts of the world are in different timezones, all times are converted to UTC in order to 
work out eg. when a mail message was sent. 

The adjustment needed to convert your local times into UTC depends on the timezone in which you work.

You record what this is by taking the Timezone option from the Configure menu on the main Turnpike 
Connect screen.

When the dialog appears, you need to give your winter timezone - either by its standard abbreviation or 
the number of hours and minutes you are ahead or behind GMT in winter as a four-digit number hhmm, 
preceded by a + if you are ahead of GMT or a - if you are behind GMT. For example, if you are 5 hours 
behind GMT (eg. on the East coast of America) you would give your timezone as -0500, but if you are 
10½ hrs ahead (eg. in South Australia), you would give it as +1030. The dialog also asks you to set your 
local 'Summertime' (or Daylight Saving) rules - typically by picking one of the standard options.

To help you ensure that you set the Timezone correctly, Turnpike responds to the setting you make with 
an indication of where you are probably located. If it is very wrong, you've probably got minus where you 
should have plus (or vice versa) 

The Timezone dialog also allows you to set:

Synchronise with: the address of the time server which Turnpike will use as a time reference. Typically, 
this will be set automatically for you from the details of your Access provider.

Automatically set the PC clock: select this check box if Turnpike should set your host PC's clock to 
match your time server. (If you want your PC to remain synchronised to some other time standard, leave 
this box clear.)



Setting up workgroups

Workgroups are the Turnpike equivalent of an office or a department within a company.

By putting users together into a workgroup, you can arrange that:
* They all have 'permission' to carry out a particular range of administrative actions - by giving these 
permissions to the group
* Mail that arrives using particular 'group' email names can be picked out and processed by any member 
of the group - by giving the group access to these names (see Group Mail)
* Mail on particular topics can be seen by any member of a workgroup - by tagging it with one of their 
'group' topic tags (see the section on special features for multiple users in the Mail&News book)

Workgroups are set up within the main Turnpike program. Assuming you have Alter workgroups 
permission, you need to select Configure from the File menu of that program, then pick Workgroups 
from the submenu that appears. This displays the 'Administer Workgroups' dialog which lists the 
workgroups that have been set up so far.

It is then a matter of picking out the users you want in the workgroup and adding them to the Current 
members list, then selecting the actions that members of this workgroup are to be allowed to carry out by 
virtue of being a member of this group.

For further information, either press F1 to call up Help from the Administer Workgroups dialog or turn to 
the section on 'Organising users into workgroups' in the 'Set-Up' book.



Setting where mail and news is stored

When Turnpike is installed, it automatically creates NEWS and MAIL directories alongside the Turnpike 
Connect program and sets up both Turnpike Connect and the main Turnpike program to use these 
directories.

If you run out of space on the current disk, and you have access to another disk, the answer may be to 
move either the NEWS directory or the MAIL directory (or perhaps both) to a different disk. (If you need to
move the whole of Turnpike to another machine or another system, click here.)

The first step is simply to use standard File Manager actions to move the directories to their new location. 
But before you do this, you should ensure that the Turnpike programs both on the host machine and on 
any other machine on your system are closed - to avoid confusion.

You will then need to record the new File Path information within both Turnpike and Turnpike Connect - 
and, if these files are accessed from other machines across a network, to let your colleagues know the 
new location of these files so that they too can record the new details in the copies of Turnpike they use.

There are two ways of recording these details. If the Sign-on dialog is displayed when the program is run, 
you simply need to click the Paths button in this dialog and then set the new path information in the File 
Paths dialog  that's displayed. If the Sign-on dialog has been disabled, you will need to edit the 
TURNPIKE.INI and the CONNECT.INI files in your Turnpike directory and record the new Newspath and 
Mailpath in the [PATHS] section of these files.



Setting your PC's clock

To avoid confusion, it is useful for your PC's clock to be synchronised with clocks used elsewhere on the 
Internet - in particular, that used by your news server. (If your clock isn't properly synchronised, you may 
miss reading some articles simply because the time it appears you last picked up mail is later than it really
was.) Some mail-handlers - though not Turnpike - can also get confused if mail appears to arrive before it 
is sent.

To allow clocks to be synchronised, a number of 'Time servers' are provided around the Internet.

When you go on-line, Turnpike automatically arranges to get the current time from one of these Time 
servers. If you like, you can arrange to have your PC's clock synchronised to this time (after making 
appropriate allowance for the timezone in which you are located and for the summertime details that 
apply) by selecting Set the PC time from the Services menu on the main Turnpike Connect screen. 

If you have some local time standard that you prefer to keep to, leave this option unticked.

Note: If there's a large difference between the current time and the time Turnpike is about to set, you will 
see a message because the chances are that the timezone hasn't been set correctly. For instructions on 
how to set this, see Setting the Timezone. 



Sign-on names are the names by which the different users of your system are known to Turnpike.

In broad terms, the same rules apply to sign-on names as email names because typically a user's sign-on
name will also be their principal email name, though this does not have to be so. However dotted names 
like John.Smith may not be accepted here (to allow us to spot where someone has entered their domain 
address by mistake).

The person who installed Turnpike sets their sign-on name the first time they ran this Connect program. 
Other users need to have a sign-on name set for them by an existing user with suitable administrative 
powers before they can run any part of the Turnpike program. This is done from the main Turnpike 
program - so for further information, either call up the on-screen Help from within that program and search
for information on Users, or turn to the section on 'Allocating users to seats' in the 'Set-Up' book.



Signing on

The first screen to be displayed is a Sign-on screen through which you give:
* Your sign-on name, and
* Your password (if any)

(This dialog is a security measure - designed to stop someone else reading your mail.)

The very first time the program is run (as part of the installation procedure), both the sign-on slot and the 
password slot will be empty. In the sign-on slot, you should give the name you intend to use as your email
name. The password you give - and indeed whether you give any password - is up to you. But if you do 
give a password, DON'T FORGET THIS because without this password, you may be locked out of 
Turnpike for ever (or at least until you re-install Turnpike from scratch).

On subsequent occasions, the Sign-on slot will be automatically filled in with the last sign-on name of the 
last user. So if that was you, you will normally just need to give any password that's required then click 
'OK'. If you weren't the last user, either type your sign-on name over the one that's shown or choose from 
a list of recently used sign-on names by clicking on the arrow.

On a shared system, everyone except the very first user will have been told both the sign-on name and 
the password to use - though you can set a different password after you've signed-on. (Click here for 
further information on this.) If you are the only user of your system, you just need to give the same 
password that you gave when you installed Turnpike.

Very occasionally other actions will be required. In particular, if the mail and/or news files have been 
moved to a new location (or you simply want to find out where these are stored), you must click the Paths
button and set the new paths for these files in the dialog that's displayed. (For further information about 
this dialog, either click here or press F1 to call up this Help file when this dialog is on your screen.)

The Site Key button included in the dialog calls up a further dialog in which the registration details of your
copy of Turnpike can be checked and updated if necessary. 

Note: If you don't use a password, you can if you wish disable this Sign-on dialog - though you are not 
recommended to do this if other people use your machine to call up Turnpike. (If you think about it, if you 
disable the sign-on dialog, everyone who loads the program after you, will be signed on as you, see your 
files etc. etc. until such time as the sign-on dialog is re-enabled.)



The Site ID is the 'serial number' of your copy of Turnpike.

The Site ID of any Evaluation copy of Turnpike is generated automatically. The Site ID for a full copy of 
Turnpike is to be found on the CD pack and you will have been asked to enter this the first time this full 
copy is run.

Anyone who has permission to run this Connect program can inspect the Site ID by taking the Site Key 
option from the Configure menu (or by clicking the Site Key button on the main Sign-on dialog), but only 
an Administrator or someone who knows the Site Secret can change it.



If you add extra features to your copy of Turnpike, for example extra 'seats' on a shared system, the 
change is recorded by entering a 'Site Key'.

The Site Key you need use and other information about this feature of Turnpike is supplied when you 
purchase the appropriate upgrade.

Note: When entering this key, you can use any combination of upper and lower case as any lower case 
characters will be automatically switched to upper case for you. You also don't need to worry whether 0 is 
a zero or the letter O, or 1 is the number one, a little l or a capital I: they're actually numbers but the 
letters will also be accepted.



The Site Secret is a code word that is used (together with the Site ID) to encrypt mail messages so that 
they can't be read by simply opening the mail files.

The Site Secret may be blank (ie. no characters) if you want, but then your mail messages are only 
encrypted with the Site ID which someone else could find out. With a specific string as your Site Secret, 
someone trying to read your mail files would need to know both your Site ID and your Site Secret.

You will probably only need to enter your Site Secret once - but you should keep a record of it (and your 
Site ID) in case you ever have to re-install your Turnpike system from scratch. If you don't use the same 
Site Secret again, you won't be able to read any of the mail messages that were received using the 
previous installation.

If you didn't keep a record of the original Site Secret, someone with administrator permission can set a 
new Site Secret by taking the Site Key option from the Configure menu (or by clicking the Site Key 
button on the Sign-on dialog) and typing a new Site Secret in the dialog that's displayed.



Site Specific Details

This dialog displays the basic registration information about your site: the Site ID and any Site Key that 
has been set.

It is displayed by taking the Site Key option from the Configure menu (or by clicking the Site Key button 
on the initial Sign-on dialog).

These details are principally displayed just for information, but occasionally new details may need to be 
set eg. to record the addition of extra seats.

The details can only be changed by someone with administrator permission - or by someone who can 
demonstrate that they know the Site Secret. Such a person can also use the dialog either to verify that 
they have the correct Site Secret (by typing this Site Secret, then clicking the Check Secret button) or to 
set a different Site Secret.

Note: When entering either a Site Key or a new Site ID, you can use any combination of upper and lower 
case as any lower case characters will be automatically switched to upper case for you. You also don't 
need to worry whether 0 is a zero or the letter O, or 1 is the number one, a little l or a capital I: they're 
actually numbers but the letters will also be accepted.



Snapshot option

Takes a snapshot of the current screen contents and saves it to a file on disk.



Software error nnn

If "Software Error" followed by a number appears, it means that one of Turnpike's internal consistency 
checks has failed.

The recommended way to think of it is as meaning "something impossible has happened" - probably 
triggered by a power cut, a GPF or some other program failure, usually while running the Connect 
program. If there was a sensible "English" explanation, this would be given. 

The error will be associated with one of the database files - usually either the news database or the 
address book. (Special precautions are taken to minimise the risk of these problems affecting the mail 
database.)

The cure is to rebuild the affected database (assuming you have Rebuild files permission). Rebuilding a 
database recreates all the indexes and other secondary information, and discards any damaged data.

But before rebuilding the database, it is a good idea to run a SCANDISK since this will ensure your file 
and directory structure is valid.

Note: It is possible that Turnpike will report an error before you get to the point where you can rebuild the 
affected database. If this happens, rename the affected file then run the main Turnpike program again. 
This time, the program will think that the file is missing and offer to create a new file. Leave this message 
on the screen while you switch to the file manager and rename the file back to its original name. Turnpike 
will then rebuild your database.



Subscribing to newsgroups

To follow the discussions in a particular newsgroup, you first need to 'subscribe' to it - ie. have the articles 
that are contributed to this newsgroup downloaded to your disk. Then to read the articles, the newsgroup 
needs to be included in a newsstand.

Newsgroups can be subscribed to by users with News Admin permission either picking out these 
newsgroups for inclusion in their newsstands or adding them to the master list of 'subscribed newsgroups'
that Turnpike keeps. This master list is called up from by taking the Configure option from the File menu 
in the main Turnpike program then selecting Newsgroups from the sub-menu that appears. As well as 
adding further newsgroups through this dialog, you can also remove newsgroups from this list that are no 
longer required, set the length of time each article is held (the Expiry time), and specify whether the 
newsgroup is to be downloaded in full or just 'browsed'.

For further details, either turn to the Turnpike Mail&News book or call up the on-screen Help from within 
the main Turnpike program and search for Subscribing to newsgroups.

Note: New newsgroups appear and old newsgroups disappear almost daily so whenever Turnpike picks 
up articles it also picks up a list of amendments to make to the list of newsgroups it offers. Alternatively, 
you can ask Turnpike to pick up a complete new list by selecting the Update option in the Configure 
Usenet News dialog (assuming that you have Connect Admin permission) This is particularly useful if you 
change the News server you use (eg. because you change Access provider) because not all News 
servers carry the same range of newsgroups.



Taking a snapshot

If you want a snapshot of the current screen display, simply select Snapshot from the menu bar. This 
saves the contents of the current screen to a file.

Note: If your PC is being used as a Network Virtual Terminal (NVT) to telnet to a remote computer, the 
snapshot will record the last 25 lines of commands and responses.



Telnet

Introduction to Telnet

The Telnet menus

How to:
Call up the required service
Ask the remote computer 'Are you there?'
Set the Terminal emulation that's used
Set your keyboard to DEC layout or PC layout as required
Set your PC's function keys to enter frequently used sequences of actions
Arrange to send commands line-by-line (instead of character-by-character)
Abandon an action you've started in error
Stop further output being sent to your machine
Take a snapshot of the current screen
Look back over earlier parts of the session
Record the session in a file



Telnet Emulation option

This option, which is available either through the Configure menu or through the Options menu offered 
when you are using Telnet, calls up a dialog through which you can set which type of terminal your 
system emulates when you log in to a remote computer using Telnet. It also allows you to set the rules by 
which output on your screen is wrapped from line to line and whether your command lines are sent 
character by character or line by line when your computer is emulating either an NVT or a simple ASCII 
terminal.

Click here for further information about the Telnet Session Options dialog
or press F1 to call up this Help file when the dialog is on your screen.



Telnet Keyboard dialog

This dialog allows you to configure your PC's keyboard in whichever way you find best when using Telnet.

Phrases: Use this part of the screen to define any command strings including special characters that you 
would like have available on your PC's function keys.

Note: (i) The shift in which the current set of phrases will be available is selected by clicking the Normal, 
Shift, Alt and Control options to the right of the list.
(ii) The Phrases shown against the background of the dialog cannot be changed.

VT100 keyboard layout: If your PC is currently emulating a DEC terminal, use this part of the dialog to 
set whether the keypad area of your keyboard will have the standard PC layout or mimic that on a DEC 
terminal.

Note: The option you select affects whether F5 - F8 are available to issue command strings. If you opt for 
the standard PC layout, F5 - F8 take on the role of PF1 - PF4. (In the DEC layout, the top four keys of the 
keypad act as PF1 - PF4.)

Click here for further information about the DEC and PC layouts.



Telnet Keyboard option

Calls up a dialog through which you can set up function keys to issue frequently used Telnet commands 
and set whether the numeric keypad on your PC has the standard PC layout or emulates the numeric 
keypad on a DEC terminal.

Note: If you opt for the standard PC layout, function keys F5 - F8 will take on the role of the 
programmable function keys PF1 - PF4 (set by the remote application). If you opt for the DEC layout, the 
top row of the numeric keypad will act as PF1 - PF4.

Click here for further information about the Keyboard Emulation dialog
or press F1 to call up this Help file when the dialog is on your screen.



Telnet Session Defaults dialog

This dialog allows you to set basic information about how your PC will act as it communicates by Telnet 
with a remote computer.

Emulation: Simply pick the option that's required.
Note: If Automatic is selected, the emulation that is used will be set by negotiation between Turnpike and
the remote computer when you connect to this computer.

Cursor: Select Solid (or thin); Flashing (or not flashing) as required.

Buffer lines: Check this box if you want commands to be sent line-by-line.

Auto-wrap: If the output from the remote computer needs to be wrapped from line to line by Turnpike at a
particular column, check this box and set the column (number of characters) at which the lines should be 
wrapped.



Telnet Terminal emulation

The terminal your PC emulates when you are connected to a remote computer is usually set to the best 
possible option by negotiation between Turnpike and the remote computer.

Should you need to set a specific emulation, you can do this by taking the Terminal emulation option 
from the Options menu.

This displays a dialog in which you can set not only the emulation but also such details as the type of 
cursor (thin or solid, flashing or static) and the column at which output to the screen should be wrapped.

Note: As far as Telnet is concerned, there's no difference between a VT102 terminal and a VT100 
terminal.

Click here for information about the dialog in which this information is set
or press F1 to call up this Help file when the dialog is on your screen.



The standard asignments for the function keys during Telnet are:

F1 Help
F2 Are you there
F3 Interrupt Process
F4 Abort Output

F5-F8 In DEC keyboard layout, User defined
In PC keyboard layout PF1-PF4

F9 Switch view
F10 Toggle menu bar

F11-F12 User defined



Telnet menus

File
Edit
Commands
Options
Snapshot
Window
Help



Special characters can be included in Telnet function key phrases as follows:

\R carriage return followed by line feed
\L line feed only
\T tab
\\ \

Note: lower case r, l and t have the same effect as the upper case shown.
\ followed by any other character or at the end of the phrase represents \



Introduction to Telnet

Telnet lets you log into and use another computer on the Internet.

A wide range of information resources held on computers on the Internet are accessed using Telnet - 
catalogues, news listings, stock exchange reports etc. In some cases, you need to open an account in 
order to use the information; in other cases, the information is available for free.

Details of the information resources available by Telnet are given in catalogues of Internet services. The 
entry for the service will tell you:
* The address that you need to telnet to
* Any special 'port' you need to quote
Where appropriate, it should also tell you the log-in name that you will need to use.

There are a number of features of Turnpike's Telnet implementation that make calling up such services 
easy.

The first is that Turnpike automatically keeps a list of the addresses and port numbers of the services you 
call up. So when you want to log in to one of these services again, you can readily call up the information 
you need.

Another feature of telnetting from Turnpike is that Turnpike automatically 'negotiates' with the server on 
the remote computer the best terminal emulation to use and the best settings for the various operating 
parameters. You don't need to set these things yourself (though you can set a specific emulation if you 
want).

If your PC is set to emulate any of the DEC terminals, you can also have your PC keyboard set up so that
the numeric keypad mimics the numeric keypad on a DEC terminal. In particular, the top four keys of this 
keypad take on the role of the programmable function keys PF1 - PF4. (If you opt to keep the standard 
PC layout for this keypad, PF1 - PF4 are put onto function keys F5 - F8.) You may well find selecting the 
DEC layout makes it easier to follow the instructions given by application you select. 

You can also set up the function keys on your PC to issue commands you often use for you. Indeed, 
some commands are preset for you, so that you just need to press F2 to ask the remote computer 'Are 
you there' or F3 to halt an action that you've started in error (provided the remote computer responds to 
this command).

Click here for information on how you call up a service that is available by Telnet.



The 'main Turnpike program' is the TURNPIKE.EXE program which is used to prepare and read Mail and 
News. It can be started from within the Connect program by clicking the Mail/News button on the Connect
program toolbar.



The permissions

The different permissions that a user may be given are as follows: (Note: Many of these only affect 
actions that can be taken within the main Turnpike program)

Administrator Automatically given permission to Configure Users (ie. add new users, set other
users' sign-on details and permissions) and Rebuild datafiles

Connect Admin Allowed to alter the Host, Timezone, Mail Transfer, News Collection and Service
Access details recorded through the Configure menu in the Connect program. 
Also allowed to Configure the Toolbar in the Connect program.

Dialling Admin Allowed to alter the Dial Settings dialog in the Connect program.

Email Admin Allowed to Configure Email Routeing - ie. to set how email is distributed to 
different users and who handles Dead Letter Mail

News Admin Allowed to Configure Newsgroups - ie. to select which newsgroups are 
subscribed to, to set how long articles remain on your disk before being expired 
and to restrict access to particular newsgroups.

Alter Users Allowed to Configure Users - ie. add new users, set other users' sign-on details 
and permissions.

Alter Workgroups Allowed to Configure Workgroups.

Alter Names Allowed to set up Email names for any user.

Add Email Names Allowed to set up Email names for themselves.

Connect to Net Allowed to run the Connect program and connect to your Access provider.

Keep articles Allowed to mark articles to be kept beyond their normal expiry time.

Kill articles Allowed to kill individual news articles and to set up Kill rules.

List Subscribe Allowed to set up mailing lists as pseudo-newsgroups available to any user.

Rebuild Files Allowed to rebuild the news database, the mail database or the address book as
required.

Ratings Admin Allowed to set the newsgroup ratings contolling which newsgroups can be seen 
by different users.

Serve POP3 Allowed to access the mail in their Turnpike mailbox from outside their Turnpike 
system.



A Time server is a computer on the Internet that is set up to issue UTC time.



Toolbar

The toolbar normally offers the following buttons:

Connect/Disconnect: Connects to / Disconnects from your Access provider.

Mail/News: Calls up the main Turnpike program so that you can see what mail messages have arrived, 
prepare further messages to send etc.

WWW: Calls up Netscape Navigator to let you browse the World Wide Web.

WS-FTP: Opens a dialog through which you can link to other sites in order to copy files by 'FTP' from 
them.

Telnet: Opens a dialog through which you can log in to a remote computer eg. to search a database held 
there.

Finger: Opens a dialog through which you can 'finger' users at other sites (and call up other non-
interactive information).

Ping: Opens a dialog through which you can 'ping' other sites in order to see whether you can get a 
response from them.

Traceroute: Opens a dialog through which you can find out about the route currently being taken between
your computer and a given Internet address.

If you have any additional applications that you would like to call up from within Turnpike, there's the 
option of adding another two buttons to the toolbar for these or of re-assigning existing buttons either to 
'Internal' features such as Finger or Ping or to 'External' applications such as an alternative FTP program. 
Click here if you would like information on this.



Traceroute

Turnpike includes a Traceroute option, which provides information about the route currently being taken 
between your machine and another Internet address.

To use this option:
* Click the Traceroute button on the toolbar
* Enter the appropriate domain name in the dialog that's displayed
* Then click the Start button.

Turnpike then works out from a series of sample messages the sequence of machines through which 
messages sent from you to the specified host will pass. The report it produces lists both the address of 
each machine and the different times taken by the sample messages for each stage of the journey 
(except where they've met with no reply).

It also reports whether the host at the destination was on-line (shown as !E) or off-line (shown as !H).

Note: As a rule, you should only use Traceroute under direction from your Access provider or some other 
expert in the workings of the Internet who can interpret the information it produces. It shouldn't be used 
for idle investigation as it makes intensive use of Internet resources which ought to be being used to 
transfer real messages across the Internet.



Troubleshooting

The main areas in which you may have problems while using Turnpike Connect are with:

Making a connection to your Access provider
Keeping that connection
The speed at which news is collected
'Software' errors
'Winsock' errors - in particular 'No buffer space'

For advice on any of these, simply click on the appropriate entry above.

For advice on the steps needed to carry out a particular action, either return to the 'Contents' page of this 
Help file and follow links from there or use the Help file 'Search' facility to look for advice under 
appropriate keyword headings.



Turnpike & Windows 95

If you have Windows 95 installed on your PC, you will be able to access the Internet using either the NTS 
Winsock supplied with Turnpike v3 or the one provided as part of the Windows 95 Dial-Up Networking 
(DUN) software. Either of these Winsocks can be used not just with Turnpike but also with any Internet 
applications that you wish to run alongside Turnpike - whether 16bit or 32bit.

In general, it is easiest and most convenient to use the NTS Winsock provided with Turnpike, because 
this allows you to run the Turnpike Connect program and go on-line in one smooth action. Setting up the 
Windows 95 DUN and using it to dial up your Access provider involves:

1. Installing your modem 
2. Installing the DUN software 
3. Installing the TCP/IP software 
4. Installing the Dial-Up Adapter 
5. Setting up a Connection icon 
6. Dialling Up 
7. Using a Dial-up script 

Note: If you need to use the Windows 95 Winsock but you have already installed Turnpike's own 
Winsock, don't worry - just use the Winsock used option offered in the Turnpike Connect program to 
select the DUN Winsock instead. (To be tidy, you could then remove the WINSOCK.NTS and 
WSOCK32.NTS files from your Windows directories - but it's not essential to do this.)

You should also note that Windows 95 Set-Up disks are needed for some of the steps, and that the 
pictures show the settings required for connecting to Demon using a Sportster 28800 modem connected 
on COM1 from a stand-alone machine. Other settings may be required if you use either a different Access
provider or a different modem - or if your PC is on a network.

If you are happy to use the NTS Winsock supplied with Turnpike, you can ignore these steps.



UTC stands for Universal Co-ordinated Time. For all intents and purposes it is the same as GMT 
(Greenwich Mean Time).



Unregistered Evaluation Version dialog

This dialog automatically appears whenever an Evaluation copy of Turnpike is run to advise when this 
time-limited copy of Turnpike will 'expire'.

(Separate dates are given for the main Turnpike program and the Connect program because the main 
Turnpike program continues to run for a few more days to give someone who doesn't wish to continue 
using Turnpike the opportunity to export any mail they've sent or received using Turnpike in a format that 
can be read by other Mail readers.)

The box at the bottom of the dialog is to tick when you have ordered a full copy of Turnpike.

Note: If the full copy hasn't arrived by the time this Evaluation version has expired, ring Technical Support
on 0181-371 1010 and ask for a 'Key' with which to extend the life of the Evaluation version.



Updating Access provider information

The information used to contact your Access provider is taken partly from the 'script' (.ACC file) for this 
Access provider and partly from the answers given to the sequence of questions Turnpike asked about 
your account with this provider.

If you change anything about the account you have - for example, you decide to take out mail forwarding -
then the easiest way to record these changes is by working afresh through the sequence of questions 
about your Access provider. To do this, either take the Service Access option from the Configure menu 
and click the New button, or click the New button alongside the Access provider slot in the Dial Settings 
dialog (assuming you have the appropriate permission to carry out these actions). Then when the 
Internet Access Provider dialog appears, check that the correct Access provider is selected in the 
Select access provider slot then click OK to work through the sequence of questions afresh.

But if things change at the Access provider end of the connection - for example, they change the address 
of their mail gateway or the IP address of a DNS server, or they either introduce new PoPs or change the 
phone numbers of existing ones - these changes need to be recorded in the Access provider's script file.

The best way of doing this is by picking up a copy of the appropriate updated script by FTP from the 
//ftp.demon.co.uk/pub/mirrors/turnpike/scripts/ directory. (Precisely what you need to do will be 
explained the Readme file included in this directory.)

In the meantime, however, it is possible make these changes by hand by editing the .ACC file. (This is a 
simple text file.) You then need to 'register' the fact that the file has changed by carrying out the 'Select 
Access provider' procedure described above for recording changes in your account.



Updating the list of newsgroups
New newsgroups appear and old newsgroups disappear almost daily so whenever Turnpike picks up 
articles it also picks up a list of amendments to make to the list of newsgroups it offers. Alternatively, if you
have Connect Admin permission, you can ask Turnpike to pick up a complete new list by selecting the 
Update option in the Configure Usenet News dialog. This is particularly useful if you change the News 
server you use (eg. because you change Access provider) because not all News servers carry the same 
range of newsgroups.



User-definable buttons

The toolbar in the Connect program can have up to 10 buttons. Button 1 (counting from the left-hand end 
of the toolbar) is always the Connect/Disconnect button, but the others can be set to call up either 
'Internal' feature of Turnpike such as Ping, Finger and the main Mail/News program - or 'External' 
applications such as an FTP program or a Web browser as you wish. (Unassigned buttons aren't shown.)

To set a button to call a particular application, select Toolbar buttons from the Configure menu in 
Connect. This displays a 'Toolbar Configuration' dialog with separate 'pages' for each of the buttons 
(numbered 1 ... 10).

Simply select the page for the appropriate settable button, then:

If you want the button to select an internal feature like Ping, select Internal command and pick the one 
you want.

Or if you want it to run an external application, select External command then use the Browse button to 
pick out the .EXE file of the program you want it to run. Then make any changes you want to the Button 
text and the Prompt text. (Note: The Button text shouldn't be more than about 10 characters)

(Or if you don't want the button to call up any program, select Internal command and pick 'Unassigned' 
from the associated drop-down list.)

When you've made all the assignments you want, click OK.

Note: The dialog also includes a Default all button which restores all the buttons to the definitions they 
were shipped with.



Using Turnpike Help

Help on Turnpike Connect can be called up in two ways:

* By clicking on a Help button: this calls up general information about the current display.
* By pressing the F1 key.
* By pressing Shift F1 and then clicking on the part of the screen you want information on

To see further information:
If you want further information about something that is underlined on the current Help page, either:
* Click on the underlined item, or
* Press the Tab key until the required item is highlighted and then press Enter.

To see information about any other aspect of Turnpike Connect, either click on the Contents button at the 
top of this window and then click on the required entry in the Contents - or click on the Search button to 
search for Help on a particular topic.

To return to information you called up earlier:
To go back to the last page of information you were looking at, click on the Back button at the top of this 
window.

To go back to an earlier screen, click on the History button at the top of this window and then double-click 
on the required screen in the list that is displayed.

For a complete description of these features, either press F1 or select 'How to Use Help' from the 
Help menu in this window.

Note: This Help display can be moved, re-sized, closed etc. in the same way as any other window. 



Viewing a Telnet session

The screen normally shows the current terminal screen contents, as modified by the latest commands 
and responses to be given.

The screen needs to show this 'Terminal screen' while commands are being given or responses received, 
but in quiet periods, it is possible to switch to a 'Session review' mode in which you can look back over a 
log of the entire session.

Pressing F9 switches between the Terminal Screen and the Session Screen.

Note: When your PC is emulating a Network Virtual Terminal (NVT), there is no separate Session view as
the Terminal screen itself provides a log of the entire session which you can scroll back over during quiet 
periods.



World Wide Web

The World Wide Web - or 'WWW' or 'the Web' as it's more commonly known - is an exciting and powerful 
way of calling up information over the Internet.

What you call up over the Web are pages of information, typically laid out like the pages of a magazine 
with lots of pictures and other graphics. (The system allows different text styles and graphics to be used 
so it's pretty much de rigeur for anyone setting up 'Web pages' to use these to make their pages as 
attractive as possible.)

There are pages to be called up on a vast range of topics - from world events to obscure musical 
instruments, alongside weather reports, stock market reports, restaurant reports, product information, 
news pages and articles from magazines etc. etc. - whatever people or organisations have chosen to 
publish in this way.

However, the important feature of these pages isn't their layout but the links they contain to other pages of
information, which you can call up simply by selecting the appropriate link - in much the same way as you 
can call up further information from a Help file by clicking on the appropriate link in the page that's 
currently displayed. (These links are usually underlined words or phrases, but pictures can also be links.) 
But whereas the links in a Help file just call up a different part of the same file, the links on Web pages 
use a system known as 'hypertext' to call up completely separate files which - through the magic of the 
Internet - may be held on opposite sides of the world.

The information available through the Web is called up by using a program known as a Web browser (so 
called because the process of searching the Web is described as 'browsing'). The browser provided for 
use with Turnpike is Microsoft Internet Explorer.

When you want to get information from the Web:
* Connect to your Access provider.
* Then click the WWW button on the toolbar to start Microsoft Internet Explorer.
To start with, you will see whichever Web page is currently set as its 'starting page'. From there, there are 
two main ways of getting to the information you want.

The first is simply to use the links on the page that's currently displayed to call up other pages and so on 
until you find the information you want. This is the primary way of calling up Web pages.

The other way is by entering the page's 'URL' in the 'Address' slot at the top of the display. (URL stands 
for Uniform Resource Locator and it's the page's address on the Web. All URLs start http://.... ) Note: If 
there isn't an Address slot at the top of the screen, call up the View menu and select Address Bar.

Once you've got the page you want on your screen, you can then either simply read the information or 
you may be able to print off a copy to keep.

* For further information about using Micosoft Internet Explorer, press F1 within the Internet 
Explorer to call up its own Help information. This information is offered separately from this Help 
file.

Note: Microsoft Internet Explorer also offers News and Email facilities, which you are perfectly free to use
but which are entirely separate from the main Turnpike News and Mail. In particular, Turnpike's News 
works with articles downloaded to your PC, which you can read off-line at your leisure. The Internet 
Explorer's News will let you read any article currently available at your Access provider's news server but 
only while you are on-line and paying connection charges.



Which modem to pick

Start by looking carefully at your modem and/or its manual to find both the name of its manufacturer and 
its full model name - or at least the name of a modem it is said to be compatible with. Then scan the part 
of this list below the 'Generic' entries for this make and model.

Turnpike supports many modems, but it's always possible your modem is not included as new models 
come out all the time

If your modem is not in the list, start by looking for a modem with a very similar name to yours. If there is 
none that is close enough which works, then try using one of the generic modem entries though please 
note that you may not then be running your modem as fast or as reliably as possible.

There are several families of generic modem driver files, and you need to select the right family. If the 
hints below, or reading the modem manual don't help then just try them... start with Rockwell, then 
Practical Peripherals, then Microcom and lastly US Robotics.

Select a Generic Rockwell entry for modems that use &K commands to select flow control and \N to 
select auto-reliable error control mode. Merely having a Rockwell chip is not a reason for using a 
Rockwell driver file.

Select a Generic Practical Peripherals entry if your modem uses &K commands to select flow 
control and &Q to select auto-reliable error control mode.

Select a Generic Microcom entry if your modem uses \Q commands to select flow control and \N3 to 
select auto-reliable error control mode....BUT look in your modem manual for a "UK compliance 
information" section: if it says the modem is supplied by the GVC Corporation, then select Generic 
GVC instead. In this case it will be using \N6 to select auto-reliable error control mode.

Select a Generic US Robotics entry if your modem uses &H and &R commands to select flow control
and uses &K to select auto-reliable error control mode.

If none of the options above appear to be suitable then try the general AT&F or ATZ entries. The former 
assumes that the manufacturer has set up the modem sensibly, the latter that you have managed to do 
so, and got it roughly right!

However, in the long term, please write to modems@turnpike.com for help. Something may be known 
about it anyway: if not, we may ask to borrow the modem manual for a few days so that we can advise 
you better - and so that we can add the modem to the Turnpike list for the benefit of other users of the 
same modem.

If you need further help, click here for details of the number to ring.



Windows 95: Using a Dial-up script

Typing the different pieces of information your Access provider requires every time you connect can be 
tedious. A better solution is to set up a 'script' that will provide this information for you. 

Windows 95 doesn't itself support dialling scripts. To get this facility, you need to add either the Dial-Up 
Scripting Tool from the Windows 95 CDROM, or the Internet Jumpstart Kit provided as part of Microsoft 
Plus - or one of the third-party scripting programs that are available.

If you don't have any scripting software at the moment, you can download a copy of the basic Microsoft 
scripting tool software from ftp://ftp.demon.co.uk/pub/mirrors/turnpike/win95/dscript.exe

Stored alongside this software is a file called demon.scp which provides the basis for a suitable script for 
Demon customers. This script may also be adaptable for use with other Access providers as pretty much 
the same procedures are used by most Access providers. 

We suggest you create a Windows.95 directory within your main Turnpike directory, dial up without a 
script, and use Turnpike's FTP program to copy these files to your Turnpike\Windows.95 directory. Then 
install the scripting tool and the script as described below. 

To install the scripting tool
The first step is to extract the various component files that go to make up the Dial-Up Scripting Tool. 

dscript.exe is a self-extracting .exe file, so to do this, you need to start a DOS session (by taking MS-DOS
Prompt from the Start | Programs menu), change directory to your Turnpike\Windows.95 directory, and 
then run dscript.exe with the command dscript [RETURN]. 

When the files have been extracted, exit from the DOS session and call up the Control Panel (eg. by 
taking Control Panel from the Start | Settings menu). Double-click on the Add/Remove Programs icon, 
then when the dialog appears, click on the Windows Setup tab, then click the Have disk button. 

When the 'Install from disk' dialog appears, click the Browse button and select the rnaplus.inf file from 
your Turnpike\Windows.95 directory - then click OK. You will then see a panel containing the single entry 
Slip and Scripting for Dial-Up Networking. Tick the box beside this entry, then clickInstall. 

When you return to the Add/Remove Programs dialog, click OK. 

To install the supplied script
Open the Dial-Up Scripting Tool now shown in the Start | Programs | Accessories menu. 

When the Dial-Up Scripting Tool dialog appears, check that the appropriate connection is selected, then 
use the Browse button to pick out the demon.scp file from your Turnpike\Windows.95 directory. 

(If you want to see what is in this script or you expect to need to change it, click the Edit button when you 
return to the Dial-Up Scripting Tool dialog.) 

Back in the Dial-Up Scripting Tool dialog, check that the option to Start terminal screen minimized isn't 
ticked, then click the Properties button underneath the list of connections. When the Connection 
Properties dialog appears, click the Configure button below the modem details, click the Options tab of 
the Modem Properties dialog and ensure that neither Bringup terminal window option is ticked. 

When you've done this, click OK back to the Windows Desktop - pausing only to accept the offer to save 



the changes you've made to theconnection if this is offered. 

When you are ready to dial
Run the Turnpike Connect program, then switch to your Dial-Up Networking folder and double-click on the
appropriate connection icon in very much the same way as you do when dialling up without a script. 

However, this time when the dialog appears, check that your username and password are entered in the 
slots provided before clicking the Connect button. (Note: These details may be filled in for you as your 
username is automatically saved while there's a special option to save your password.) 

You should then go straight through to the 'Connected' dialog without any further intervention from you - at
which point, you should then promptly switch back to the Connect program and allow this to continue.

(For other information about using the Windows 95 DUN to dial up, click here.)



Using the Windows 95 DUN to dial up

Note: Dialling up is easiest with the different pieces of information you need to give recorded as a 'script'. 
However, this requires extra software as Windows 95 itself doesn't support dialling scripts. If you have 
suitable scripting software (or you would like to know how to acquire this), see 'Using a Dial-up script'. 
Otherwise, dial up as described here.

Dialling up without a script

Preparation
If you will be dialling up without a script, you first need to arrange that a terminal window will be displayed 
after dialling for you to enter the different pieces of information that your Access provider requires.

To do this, select the appropriate Connection icon in your Dial-Up Networking folder, take the Properties 
option from the File menu, then click the Configure button under the modem in the Connection details 
that are displayed (This displays the basic details of the connection.).

When the dialog appears, click the Options tab and tick the option to Bring up terminal window after 
dialing. 

Then click OK back to the Dial-Up Networking folder. 

When you are ready to dial 
First run the Turnpike Connect program.

When the 'third-party Winsock' message appears leave this message on the screen for the moment and 
switch either to some other application or to the appropriate Connection icon in your Dial-UpNetworking 
folder and use this to connect to the Internet.

You will then see a 'Connect To' dialog.

Leave the slots for your username and password blank, and simply click the Connect button.

After dialling, a terminal window will be displayed - probably containing brief details of the connection that 
has been made, followed by one or more requests for information. 

The likely sequence is login name (ie. user or 'nodename'), password, then protocol (normally PPP).

To each such request, type the appropriate details and press RETURN. After the last item, click Continue
(or press f7).

Note: If you are in the process of signing up for a Trial account with Demon, you need to give olr as both 
your login name and your password. On subsequent occasions, however, you will need to give the host 
name and the password you chose for your Demon account. (Remember to make a note of these!) Note 
too that you may see a message later advising you that your Services file isn't any good, but in this case 
(but only this case), you can ignore this message.

When you are connected, you will see a 'Connected to' dialog showing your Access provider. At this point,
you need to promptly switch back to the Connect program and allow this to continue.

The next step is to use Dial-up script. 

(For other information about using the Windows 95 DUN to dial up, click here.)





Installing the Windows 95 DUN software

This is done from the Control Panel which is called up, for example, from the Settings option of the Start 
menu.

Double-click on the Add/Remove programs icon in the Control Panel.

Click the Windows Setup tab, select the Communications option and click the Details button.

Tick Dial-Up Networking, and click OK - then click OK again to leave the Add/Remove programs dialog.

(If Dial-Up Networking is already ticked, just click OK back to the Control Panel, then go on to 'Install the 
TCP/IP software'.)
 
Follow the instructions that appear on the screen to install the DUN software.

When the 'Network' dialog is displayed, fill in your 'host' or 'node' name as your 'Computer name' and an 
appropriate 'Workgroup name'. (If you are a Demon customer, your hostname / nodename is the unique 
account name you chose when you set up your account. If you are in the process of signing up for a Trial 
account with Demon Internet, give your host name as olr)

You can also fill in a Computer description if you wish.

Then restart your computer when you are prompted to do this.

The next step is to install the TCP/IP software.

(For other information about using the Windows 95 DUN to dial up, click here.)



Windows 95: Installing the Dial-Up Adapter

If the list of Network components is not already displayed, double-click Network in the Control Panel to 
call it up.

If Dial-Up Adapter is already listed, ensure that Windows Logon is selected as the Primary Network 
Logon, then set the properties of the Dial-Up Adapter as described below.

If Dial-Up Adapter isn't listed, click the Add button and select Adapter from the following list of Network 
Component Types.

Click Add again and select Microsoft Dial-Up Adapter from the following list of Network adapters. 

When you return to the main list, ensure 'Windows Logon' is selected as the Primary Network Logon - 
then set the properties of the Dial-Up Adapter as described below.

Dial-Up Adapter properties
To set these, select Dial-Up Adapter in the list of Network components (see above) and click the 
Properties button. 

Driver Type page of dialog
Leave this alone.

Bindings page of dialog
Ensure that TCP/IP is ticked - and that the other protocols are cleared. 

Advanced page of dialog
Leave these settings alone too.

When all set, click OK/Close back to the Control Panel. You now need to set up an icon for the 
connection you wish to make.

(For other information about using the Windows 95 DUN to dial up, click here.)



Windows 95: Installing the TCP/IP software

(This is also done from the Control Panel - called up, for example, from the Settings option of the Start 
menu.)

Double-click on the Network icon in the Control Panel to display a list of the installed Network 
components.

If TCP/IP isn't listed, click Add and select Protocols from the list that is displayed.

(If TCP/IP is listed, simply select it - then set its properties as described below.)

Click Add again and select Microsoft TCP/IP from the following list of Network Protocols.

Click OK, then set the TCP/IP properties as described below. 

TCP/IP Properties
To set these, select TCP/IP in the list of Network components (as described above) and click the 
Properties button. 

IP Address page of dialog

Take the 'Obtain automatically' option - unless specifically told otherwise by your Access provider. Note: If 
you are in the process of signing up for a Trial account with Demon Internet, you must select the 'Obtain 
automatically' option.

WINS configuration page of dialog
Take the 'Disable' option - unless you are on a local network where WINS is used. 

Gateway page of dialog
Set this if your Access provider or Network manager tells you the number to use, but otherwise leave it 
blank. This gateway doesn't have any real meaning on a dial-up connection.

Bindings page of dialog
The default is for TCP/IP to be bound to Client for Microsoft Networks. Leave it like this, though it does no
harm if it isn't bound. 

Advanced page of dialog
You don't need to alter this. 

DNS configuration page of dialog
If you are about to sign up for a Trial account with Demon Internet, you need to fill in olr as the Host, 
demon.co.uk as the Domain, and 158.152.1.58 and 158.152.1.43 as the DNS Servers (as shown). In 
other cases, you can find out the addresses you need by running the Turnpike Connect program and 
taking the Service access option from the Configure menu.

When you have finished making these settings, click OK back to the Network dialog. The next step is to 
install the Dial-Up Adapter. 

(For other information about using the Windows 95 DUN to dial up, click here.)



Windows 95: Installing your modem

To install and configure your modem, call up the Control Panel (for example, from the Settings option of 
the Start menu) and double-click on the Modems icon.

With no modem yet installed on your PC, you should see an 'Install New Modem' dialog.

(If a modem is installed, you will see instead a list of modems. If your modem is listed, go on to set its 
properties as described below. If not, click the Add button to display this 'Install New Modem' dialog.)

Opt for Windows to detect the modem (by ensuring that the tick box by the 'Don't detect' option is 
cleared), then click Next.

Windows then tries to identify your modem.

If your modem is correctly identified, simply click the Next button.

If it isn't correctly identified, click the Change button and select the modem's manufacturer and model 
from the the list displayed.

(If your modem isn't listed, either take the 'Have disk' option if a disk was supplied with the modem or 
select the 'Standard' modem of the appropriate baud rate - from the top of the Manufacturers list.)

When you are ready to continue, click the Next button and, if necessary, set the port to which the modem 
is attached.

If you are installing a modem for the first time, you will then be asked for details of your location and your 
phone system.

In the final dialog, you are offered a Finish button. When you click this, you will be put into the Modem 
Properties dialog from where you can set the properties of your modem as described below. 

Setting its properties
Check your modem is selected in the Modem Properties dialog, then click the Properties button and set 
its properties as follows.

General properties (Displayed first) 

The speaker volume is up to you but the speed to set depends on the modem and the type of UART in 
the COM port - and also on how fast your PC is able to respond. Ideally, the speed set here should be 4 
times the modem speed eg. 57600 for a 14.4k modem or 115200 for a 28.8k modem. But data can only 
be transmitted at these speeds if the COM port uses a 16550 UART (and then only if the PC itself can 
cope at these speeds). If it uses a 16450 UART, the highest speed to set is 38400, while if it uses an 8250
UART, the limit becomes 19200.

Note: If you don't know what type of UART is used, you can find out by returning to the Modem Properties
dialog, switching to the Diagnostics display, selecting the appropriate port and clicking the More info 
button. 

Connection properties (Displayed by clicking on the Connection tab) 

Connection preferences: The default settings of '8, None, 1' are the ones you are likely to need here.

Call preferences: This 'Wait for dial tone' option should be selected unless your modem isn't able to 
detect the appropriate dial tone.



Now click the Advanced button to show the 'Advanced Connection Settings' dialog.

Error control: is automatically selected where it is supported by your modem.

Flow control: Here you need to select the form of Flow control used by your Access provider.

Modulation type: The 'Standard' setting should be fine.

Extra settings: Slot for additional modem initialisation commands. These may be needed if Windows 95 
didn't recognise your modem.

When you have finished setting your modem's properties, click OK/Close until you are back to the 
Control Panel. The next step is to install the Windows 95 Dial-Up Networking (DUN) software.

(For other information about using the Windows 95 DUN to dial up, click here.)



Windows 95 DUN: Setting up a Connection icon

Select 'My computer' and open the Dial-Up Networking folder.

Assuming this is the first time you have gone into this folder, you will see a Welcome screen followed by a
'Make New Connection' dialog. 

(If you have another connection set up, open the Dial-Up Networking folder and click on the Make New 
Connection icon.)

Enter a name for the connection (such as Demon Internet), and select the modem you intend to use (if 
you have a choice).

Click Next.

In the next dialog, enter the details needed to phone your Access provider (0845 353 5666 if you are 
about to sign up for a Demon Trial account). 

Be sure to set the correct country.

Click Next, then click Finish in the next display.

You are then returned to the Dial-Up Networking folder.

Back in the Dial-Up Networking folder, select the new connection icon, then take Properties from the File 
menu. (This will display the basic details of the connection you've set up.)

Click the Server Type button and set the required details in the dialog that's displayed. 

Advanced options: Clear these options unless specifically needed.

Allowed network protocols: Ensure that TCP/IP is ticked and that the other protocols are cleared.

Then click the TCP/IP Settings button, and set your Access Provider's DNS addresses in the following 
TCP/IP Settings dialog.

IP address: Select Server assigned IP address unless specifically told otherwise by your Access 
provider.

Name server details: The numbers needed here are the ones you entered when setting the TCP/IP 
properties 

When you have finished setting these Server details, click OK back to the DUN folder. The next step is to 
dial up.

(For other information about using the Windows 95 DUN to dial up, click here.)



Window menu

Cascade
Tile
Arrange icons

Terminal screen (Telnet only)
Session review (Telnet only)

List(s) of windows



Window menu: Arrange icons

Arranges the icons used for any minimised Turnpike windows neatly along the bottom of the display.



Window menu: Cascade

Arranges the open Turnpike windows in a cascade one on top of the other, starting from the top left-hand 
corner of the main Turnpike screen area.

See also: Tile



Window menu: List(s) of windows

Lets you select and display the different Turnpike windows currently either open on the screen or shown 
minimised.



Window menu: Session review (Telnet only)

Switches into the 'Session view' of a Telnet session in which you can scroll through the different 
commands and responses that have been given throughout the session.

Note: This option should only be selected in 'quiet' periods when you aren't expecting any data to be sent 
from the remote computer. The display needs to be switched back into the standard 'Terminal screen' 
view when such information arrives.

Quick keystroke: F9

See also: Terminal screen



Window menu: Terminal screen (Telnet only)

Switches back to the standard Terminal display within a Telnet session.

Quick keystroke: F9

See also: Session review



Window menu: Tile

Displays the open Turnpike windows side by side within the area of the Turnpike screen.

See also: Cascade



Windows error
Consult your Windows documentation.



Winsock error - no buffer space
Under some circumstances, the Winsock will report that it has run out of buffer space.

This doesn't cause you to lose any email or news, but it is obviously inconvenient. So if you find this 
happens, we recommend editing the NTS.INI file to be found in \windows and changing the SendLimit= 
setting in the [WINSOCK] section to 2048 (it is usually 8192). This will limit resource usage and so avoid 
the problem.



Winsocks
The Winsock you use is the ultimate interface through which Turnpike and Internet applications you run 
alongside Turnpike send and receive information across the Internet.

Turnpike is supplied with both a 16bit Winsock (for use on Windows 3.x systems and with 16bit 
applications) and a 32bit Winsock for use with 32bit applications under Windows 95 - both from Network 
TeleSystems (NTS). The 16bit Winsock is provided as a Winsock.dll file; the 32bit Winsock as a 
Wsock32.dll file.

In general these are the Winsocks you are recommended to use because they allow you to run the 
Turnpike Connect program and go on-line in one smooth action. (The exception is where you are running 
Turnpike under Windows NT.)

But you may well have Winsocks from other software already on your system - for example, the ones 
provided as part of the Windows 95 DUN software - which you may prefer to use instead of the NTS 
ones, for example because they offer features that you particularly want to use, though note that you may 
then have to use separate software to dial up your Access provider. You should also make a note to click 
the Help button when you see a message telling you that you are 'Using a third-party WINSOCK' - for 
instructions on what to do.

You get to pick the Winsock you use when you install, but you don't have to stay with the one you pick 
then. If you want to change to a different Winsock, just pick the one you want to use through the Select 
Winsock dialog.



Workgroups
*** Only relevant on shared systems ***

A workgroup is a group of users on a shared system any one of which can reply to, file etc. mail that 
arrives for this workgroup. They are particularly useful within a company where you might set up 
workgroups to handle such things as Sales enquiries or Customer Support enquiries.

When a piece of mail arrives for a workgroup, it appears in the In-tray of every member of the group but 
the moment any member reads it, it then becomes theirs to deal with and disappears from other 
members' In-trays.

Workgroups are set up from the main Turnpike program, so for further information either call up the on-
screen Help within that program and search for information on Workgroups or read the section on 
Organising users into workgroups in the Set-Up book.






